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Product notice

Software terms

This user guide describes features that are
common to most models. Some features may
not be available on your computer.

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to be
bound by the terms of the HP End User License
Agreement (EULA). If you do not accept these
license terms, your sole remedy is to return the
entire unused product (hardware and software)
within 14 days for a full refund subject to the
refund policy of your seller.

Not all features are available in all editions of
Windows. This computer may require upgraded
and/or separately purchased hardware, drivers
and/or software to take full advantage of
Windows functionality. Go to
http://www.microsoft.com for details.

For any further information or to request a full
refund of the price of the computer, please
contact your seller.
This computer may require upgraded and/ or
separately purchased hardware and/or a DVD
drive to install the Windows 7 software and
take full advantage of Windows 7 functionality.
See http://windows.microsoft.com/en-us/
windows7/get-know-windows-7 for details.

Important Notice about Customer Self-Repair Parts
CAUTION: Your computer includes Customer Self-Repair parts and parts that should only be accessed by an
authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair
parts," for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for
Authorized Service Provider parts," can damage the computer or void your warranty.
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Important Notice about Customer Self-Repair Parts

Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not place
the computer directly on your lap or obstruct the computer air vents. Use the computer only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as
pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft
surface, such as pillows or rugs or clothing, during operation. The computer and the AC adapter comply with
the user-accessible surface temperature limits defined by the International Standard for Safety of
Information Technology Equipment (IEC 60950-1).
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Product description
Category

Description

Product Name

HP ZBook Studio G3 Mobile Workstation
Model numbers: 15-ap000 – 15ap099

Processors

6th Generation Intel® Core™ i7 Processor, Skylake, quad-core, BGA:
●

Intel Core i7-6820HQ 2.70-GHz (up to 3.60-GHz) processor (2133-MHz front-side bus
(FSB), 8.0-MB L3 cache, 45 W)

●

Intel Core i7-6700HQ 2.60-GHz (up to 3.50-GHz) processor (2133-MHz front-side bus
(FSB), 6.0-MB L3 cache, 45 W)

●

Intel Core i5-6440HQ 2.60-GHz (up to 3.50-GHz) processor (2133-MHz front-side bus
(FSB), 6.0-MB L3 cache, 45 W)

●

Intel Core i5-6300HQ 2.30-GHz (up to 3.20-GHz) processor (2133-MHz front-side bus
(FSB), 6.0-MB L3 cache, 45 W)

6th Generation Intel Xeon® Processor, Sky Lake, quad-core, BGA:
●

Xeon E3-1545M, 2.90-GHz (up to 3.80-GHz) processor (2133-MHz front-side bus (FSB),
8.0-MB L3 cache, 45 W)

●

Xeon E3-1505M, 2.80-GHz (up to 3.70-GHz) processor (2133-MHz front-side bus (FSB),
8.0-MB L3 cache, 45 W)

Chipset

Mobile Intel CM236 chipset

Graphics

Intel UMA Graphics - with shared video memory
Core processors: Intel HD graphics 530
Xeon processors: Intel HD graphics P530
Xeon processors: Intel Iris™ Pro Graphics P580
Discrete graphics
NVIDIA® Quadro® M1000M NVIDIA N16P-Q1 with 4-GB GDDR5 graphics subsystem memory
(128-MB×16, 1.35-V, 1400-MHz, qty 8, 128-bit, FBW)
Support for hybrid (switchable) graphics
Support for open GL
Support for DisplayPort 1.2
Support for NVIDIA Mosaic Technology

Panel

15.6-in, light-emitting diode (LED) backlight
●

Full-high definition (FHD), AntiGlare (AG), UWVA (1920×1080 resolution, 300 nits), with
or without camera or touch screen with camera

●

Ultra-high definition (UHD), AntiGlare (AG), UWVA (3840×2160 resolution, 340 nits), with
or without camera

●

Ultra-high definition (UHD), AntiGlare (AG), UWVA (3840×2160 resolution, 340 nits),
Dream Color, with or without camera

All panels are 16:9 aspect ratio
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Category

Description

Memory

Two customer-accessible/upgradable memory module slots
Support for DDR4 2133-MHz PC4-17000 dual channel memory
Support for 32-GB of system RAM in the following configurations:
DDR4-2133: (for models with Core processors)
●

32-GB total system memory (16-GB×2)

●

16-GB total system memory (16-GB×1 or 8-GB×2)

●

8-GB total system memory (8192-GB×1, 4096-GB×2)

ECC DDR4-2133: (for models with Xeon processors)

Primary M.2 storage

●

32-GB total system memory (16-GB×2)

●

16-GB total system memory (16-GB×1 or 8-GB×2)

●

8-GB total system memory (8192-GB)

M.2 (NGFF) SS/DS Solid State Drive (2280)
SATA:
512-GB SATA-3 self-encrypting drive (Opal 2)
512-GB SATA-3 self-encrypting drive (Opal 2), TLC
512-GB SATA-3, TLC
256-GB SATA-3 self-encrypting drive (Opal 2)
256-GB SATA-3 self-encrypting drive (Opal 2), TLC
256-GB SATA-3, TLC
128-GB SATA-3, TLC
PCIe:
1 TB (NVMe)
1 TB (NVMe), TLC
512 GB (NVMe)
512 GB (NVMe), TLC
256 GB (NVMe)
256 GB (NVMe), TLC

Secondary M.2 storage

M.2 (NGFF) SS/DS Solid State Drive (2280)
SATA:
512-GB SATA-3 self-encrypting drive (Opal 2)
512-GB SATA-3 self-encrypting drive (Opal 2), TLC
512-GB SATA-3, TLC
256-GB SATA-3 self-encrypting drive (Opal 2)
256-GB SATA-3 self-encrypting drive (Opal 2), TLC
256-GB SATA-3, TLC
128-GB SATA-3, TLC
PCIe:
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Category

Description
1 TB (NVMe)
1 TB (NVMe), TLC
512 GB (NVMe)
512 GB (NVMe), TLC
256 GB (NVMe)
256 GB (NVMe), TLC

Audio and video

Stereo speakers
Dual array microphone
Intel SST Audio
Conexant Smart Amplifier & Ambient Noise Suppression with DTS Studio Sound
Integrated HD 720p webcam
Support for no webcam option

Ethernet

Intel I219-LM 10/100/1000 Ethernet, with Intel I217-LM Gigabit Network Connection
S3/S4/S5 wake on LAN

Wireless

WLAN
Integrated wireless local area network (WLAN) options by way of wireless module
Two WLAN antennas built into display assembly
Support for the following WLAN formats:
●

Intel Dual Band Wireless-AC 7260 802.11 AC 2x2 WiFi + BT 4.2 Combo Adapter

●

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.2 combo

WPAN
Bluetooth® 4.2 only supported via combo card
External media cards

Integrated SD UHS-II flash media slot
Supports next generation SD, SDHC, SDXC

Ports

●

Multi-Pin AC Port

●

Combination mic-in/stereo headphone jack

●

RJ-45 (Ethernet)

●

USB Type-C Thunderbolt (2)

●

USB 3.0 (2)

●

USB 3.0 charging

●

HDMI

Docking

Docking support for HP Advanced Docking Station

Keyboard/pointing devices

Keyboard
Backlit
DuraKeys
TouchPad
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Category

Description
●

On/off button

●

Glass with chemical etched surface

●

Taps enabled by default

●

Gestures enabled by default:

●
Power requirements

–

2-finger scrolling

–

2-finger zoom (pinch)

Image sensor TouchPad

AC adapter
150-W, HP Smart Adapter, slim
Battery
4-cell, 64-WHr, 4.21-AHr, Li-ion battery
Power cord (localized)
3-wire plug, 1.8 m (with ground pin)

Security

Support security lock
Trusted platform module (TPM) 9760 1.2/2.0 (Infineon; soldered down)
Fingerprint reader
BIOS Preboot power on - BIOS option (Password, Fingerprint)
Drive Encryption preboot option (fingerprint, password, smart card)

Operating system

Preinstalled:
●

Windows 10 Home 64 Plus

●

Windows 10 Home 64 Chinese Market CPPP

●

Windows 10 Home 64 Plus Chinese Market

●

Windows 10 Home 64 Plus Single Language

●

Windows 10 Professional 64

●

Windows 10 Professional 64 Downgrade Windows 7

●

Windows 10 Professional 64 Downgrade to Windows 7 MS Volume License

●

Windows 10 Professional 64 Workstation Tier 1

●

Windows 10 Professional 64 Workstation Tier 1 Downgrade Windows 7 64

●

Windows 10 Professional 64 Workstation Tier 1 Downgrade Windows 7 64 MSVL

●

Windows 7 Professional 64

Restore media-DRDVD:
●

DRDVD Windows 10 TH12 (available with any Windows 10 operating system and
required with any Windows 10 Downgrade operating system)

●

DRDVD Windows 7 Service Pack 1 (available with any Windows 7 or Windows 10
Downgrade operating system)

Restore media-OSDVD:
●
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Windows 10 (only available and required with Windows 10 Downgrade operating
system; not available in People’s Republic of China or Asia )

Category

Description
●

Windows 7 Service Pack 1 (available with any Windows 7 Professional or Windows 10
Downgrade operating system; not available in the People’s Republic of China or Asia)

Certified:
●

Microsoft WHQL

Supported:
●

Red Hat® Enterprise Linux (RHEL) 6.x 64bit

●

Red Hat® Enterprise Linux (RHEL) 7.x 64bit

Web-only support:

Serviceability

●

Windows 10 Enterprise

●

Windows 7 Enterprise 64-bit, Service Pack 1

●

Windows 8.1

●

Red Hat Enterprise Linux

End user replaceable parts:
●

AC adapter

●

Battery (system)

●

Memory modules

●

Solid-state drive

●

WLAN module
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External component identification

Display

Component

Description

(1)

WLAN antennas* (select products only)

Send and receive wireless signals to communicate with wireless local
area networks (WLANs).

(2)

Internal microphones (2) (select products only)

Record sound.

(3)

Webcam light (select products only)

On: The webcam is in use.

(4)

Webcam (select products only)

Records video and captures photographs. Some models allow you to
video conference and chat online using streaming video.
To use the webcam in Windows 10:
▲

Type camera in the taskbar search box, and then select
Camera.

For information on using the webcam in Windows 7, select Start > All
Programs > Communication and Chat > HP WebCam.
*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions.
For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices that applies to your country or
region.
To access this guide in Windows 10:
1.

Type support in the taskbar search box, and then select the HP Support Assistant app.
‒ or –
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Component

Description

Click the question mark icon in the taskbar.
2.

Select My PC, select the Specifications tab, and then select User Guides.

To access the user guides in Windows 7, select Start > All Programs > HP Help and Support > HP Documentation.

Top
TouchPad

Component

Description

(1)

TouchPad on/off button

Turns the TouchPad on and off.

(2)

TouchPad zone

Reads your finger gestures to move the pointer or activate
items on the screen.

Top
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Lights

Component
(1)

Description
Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state, a power-saving
state. The computer shuts off power to the display and
other unneeded components.

●

Off: The computer is off or in Hibernation. Hibernation is a
power-saving state that uses the least amount of power.

(2)

Caps lock light

On: Caps lock is on, which switches the key input to all capital
letters.

(3)

Microphone mute light

●

Amber: Microphone sound is off.

●

Off: Microphone sound is on.

(4)

Num lock light

On: Num lock is on.

(5)

Wireless light

On: An integrated wireless device, such as a wireless local area
network (WLAN) device and/or a Bluetooth® device, is on.
NOTE: On some models, the wireless light is amber when all
wireless devices are off.

(6)

(7)

8

Mute light

TouchPad light
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●

Amber: Computer sound is off.

●

Off: Computer sound is on.

●

On: The TouchPad is off.

●

Off: The TouchPad is on.

Buttons, speakers, and fingerprint reader

Component
(1)

Description
Power button

●

When the computer is off, press the button to turn on the
computer.

●

When the computer is on, press the button briefly to initiate
Sleep.

●

When the computer is in the Sleep state, press the button
briefly to exit Sleep.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button results
in the loss of unsaved information.
If the computer has stopped responding and shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.
To learn more about your power settings in Windows 10, see your
power options.
▲

Type power in the taskbar search box, and then select
Power and sleep settings.
‒ or –
Right-click the Start button, and then select Power
Options.

To learn more about your power settings in Windows 7: Select
Start > Control Panel > System and Security > Power Options.
(2)

Wireless button

Turns the wireless feature on or off but does not establish a
wireless connection.

Top
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Component

Description
A wireless network must be set up before a wireless connection is
possible.

(3)

Volume mute button

Mutes and restores speaker sound.

(4)

Speakers (2)

Produce sound.

(5)

Fingerprint reader (select products only)

Allows a fingerprint logon to Windows, instead of a password
logon.

Left

Component
(1)

Description
Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or
stolen.

(2)

RJ-45 (network) jack/status lights

Connects a network cable.
●

Green (left): The network is connected.

●

Amber (right): Activity is occurring on the network.

(3)

USB 3.0 port

Connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner, or USB hub.

(4)

USB 3.0 charging (powered) port

Connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner, or USB hub. Standard USB ports
will not charge all USB devices or will charge using a low current.
Some USB devices require power and require you to use a
powered port.
NOTE: USB charging ports can also charge select models of
cell phones and MP3 players, even when the computer is off.

(5)
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Memory card reader
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Reads optional memory cards that store, manage, share, or
access information.

Right

Component
(1)

Description
Audio-out (headphone)/Audio-in (microphone)
combo jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or a television audio cable. Also connects an
optional headset microphone. This jack does not support
optional microphone-only devices.
WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, refer to the Regulatory,
Safety, and Environmental Notices.
To access this guide in Windows 10:
1.

Type support in the taskbar search box, and then select
the HP Support Assistant app.
‒ or –
Click the question mark icon in the taskbar.

2.

Select My PC, select the Specifications tab, and then
select User Guides.

To access the user guides in Windows 7, select Start > All
Programs > HP Help and Support > HP Documentation.
NOTE: When a device is connected to the jack, the computer
speakers are disabled.
(2)

USB 3.0 port

Connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner, or USB hub.

(3)

HDMI port

Connects an optional video or audio device, such as a highdefinition television, any compatible digital or audio
component, or a high-speed High Definition Multimedia
Interface (HDMI) device.

(4)

USB Type-C (charging) ports (2)

Connect any USB device with a Type-C connector.
NOTE: USB Type-C ports charge products such as cell phones,
laptops, tablets, and MP3 players, even when the computer is
off. Also, some USB Type-C ports connect DisplayPort, VGA,
HDMI and other video devices to provide video output.
NOTE:

Adapters (purchased separately) may be required.

(5)

Power connector

Connects an AC adapter.

(6)

AC adapter and battery light

●

White: The AC adapter is connected.

Right
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Component

Description
●

Off: The AC adapter is not connected.

Front

Component
(1)

Description
Wireless light

On: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth® device, is
on.
NOTE: On some models, the wireless light is amber when
all wireless devices are off.

(2)

(3)

Power light

Battery light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state, a powersaving state. The computer shuts off power to the
display and other unneeded components.

●

Off: The computer is off or in Hibernation.
Hibernation is a power-saving state that uses the
least amount of power.

When AC power is connected:
●

White: The battery charge is greater than 90 percent.

●

Amber: The battery charge is from 0 to 90 percent.

●

Off: The battery is not charging.

When AC power is disconnected:

(4)
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Drive light
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●

Blinking amber: The battery has reached a low
battery level. When the battery has reached a critical
battery level, the battery light begins blinking
rapidly.

●

Off: The battery is not charging.

●

Blinking white: The storage device is being accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the
storage device.

Bottom

Component
(1)

Description
Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

Bottom
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Labels
The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel internationally with the computer.
IMPORTANT: Check the following locations for the labels described in this section: the bottom of the
computer, inside the battery bay, under the service door, or on the back of the display.
●

Service label—Provides important information to identify your computer. When contacting support, you
will probably be asked for the serial number, and possibly for the product number or the model number.
Locate these numbers before you contact support.
Your service label will resemble one of the examples shown below. Refer to the illustration that most
closely matches the service label on your computer.

Component
(1)

Serial number

(2)

Product number

(3)

Warranty period

(4)

Model number (select products only)

Component
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(1)

Model name (select products only)

(2)

Product number

(3)

Serial number

(4)

Warranty period

●

Regulatory label(s)—Provide(s) regulatory information about the computer.

●

Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval
markings for the countries or regions in which the devices have been approved for use.

Chapter 2 External component identification
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Item

Component

Spare part number

(1)

Display assembly: The DreamColor display assembly is spared as a whole unit assembly only. The LED display assembly is
spared at the subcomponent level only. For more LED display assembly spare part information, see Display assembly
subcomponents on page 19.
15.6-in, UHD, UWVA, DreamColor display assembly not equipped with a webcam

840945-001

15.6-in, UHD, UWVA, DreamColor display assembly equipped with a webcam

840946-001

15.6-in, FHD, UWVA display assembly with a touch screen

840947-001

(2)

Top cover

840636-001

(3)

TouchPad (includes cable)

840962-001

(4)

RTC battery (includes cable and double-sided adhesive)

840953-001

(5)

Fingerprint reader board (includes bracket)

840952-001

(6)

Keyboard (includes keyboard cable):
For use in Belgium

841681-A41

For use in Brazil

841681-201

For use in Bulgaria

841681-261

For use in Canada

841681-DB1

For use in the Czech Republic and Slovakia

841681-FL1

For use in Denmark

841681-081

For use in France

841681-051

For use in Germany

841681-041

For use in Greece

841681-151

For use in Hungary

841681-211

For use in Iceland

841681-DD1

For use in India

841681-D61

For use in Israel

841681-BB1

For use in Italy

841681-061

For use in Japan

841681-291

For use in Latin America

841681-161

For use in the Netherlands

841681-B31

For use in Northwest Africa

841681-FP1

For use in Norway

841681-091

For use in Portugal

841681-131

For use in Romania

841681-271

For use in Russia

841681-251

For use in Saudi Arabia

841681-171

For use in Slovenia

841681-BA1
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Item

Component

Spare part number

For use in South Korea

841681-AD1

For use in Spain

841681-071

For use in Sweden and Finland

841681-B71

For use in Switzerland

841681-BG1

For use in Taiwan

841681-AB1

For use in Thailand

841681-281

For use in Turkey

841681-141

For use in the United Kingdom and Singapore

841681-031

For use in the United States

841681-001

(7)

LED board

840957-001

(8)

Speakers (include cable)

840958-001

(9)

System board (includes processor and replacement thermal material):
All system boards use the following part numbers:
xxxxxx-001: Windows 7 or non-Windows operating systems
xxxxxx-601: Windows 10 operating system
Intel Xeon E3-1545M processor

840934-xxx

Intel Xeon E3-1505M processor

840933-xxx

Intel Core i7-6820HQ processor and discrete graphics memory

840932-xxx

Intel Core i7-6820HQ processor and UMA graphics memory

840930-xxx

Intel Core i7-6700HQ processor and discrete graphics memory

840931-xxx

Intel Core i7-6700HQ processor and UMA graphics memory

840929-xxx

Intel Core i7-6440HQ processor and discrete graphics memory

900200-xxx

Intel Core i7-6440HQ processor and UMA graphics memory

913334-xxx

Intel Core i7-6300HQ processor and discrete graphics memory

863779-xxx

Intel Core i7-6300HQ processor and UMA graphics memory

913333-xxx

(10)

Display cable (eDP) bracket (included in Bracket Kit, spare part number 840966-001)

840966-001 (Bracket Kit)

(11)

I/O support bracket (included in Bracket Kit, spare part number 840966-001)

840966-001 (Bracket Kit)

Fan/heat sink assembly (includes replacement thermal material):
(12)

For use only with models with discrete graphics memory

840960-001

For use only with models with discrete graphics memory (4 + 4E)

900285-001

(13)

For use only with models with UMA graphics memory

840961-001

(14)

Solid-state drive (SSD), M.2:
1-TB, Z Turbo drive PCIe

840951-001

512-GB, Z Turbo Drive, PCIe

840950-001

Computer major components
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Item

Component

Spare part number

512-GB, SATA-3, self-encrypting drive (SED), OPAL2, MLC

860756-001

512-GB, SATA-3, self-encrypting drive (SED), OPAL2, TLC

923709-001

512-GB, locked, for Proctor & Gamble

919662-001

512-GB, SATA-3, TLC

922236-001

256-GB, Z Turbo Drive, PCIe

840949-001

256-GB, SATA-3, self-encrypting drive (SED), OPAL2, TLC

930462-001

256-GB, SATA-3, TLC

922235-001

128-GB, TLC

846386-001

(15)

Solid-state drive bracket (included in Bracket Kit, spare part number 840966-001)

840966-001 (Bracket Kit)

(16)

Memory module (PC4, 17000, 2133-MHz):
For use with Core processors:
●

16 GB

820571-002

●

8 GB

820570-002

●

4 GB

820569-002

For use with Xeon processors:

(17)
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●

16 GB, ECC

835886-002

●

8 GB, ECC

835887-002

WLAN module:
Intel Dual Band Wireless-AC 8260 3rd Gen Intel 802.11ac, Dual Band, 2x2 Wi-Fi + Bluetooth
4.2

806721-005

Intel Dual Band Wireless-AC 8260 3rd Gen Intel 802.11ac, Dual Band, 2x2 Wi-Fi + Bluetooth
4.2 (non-vPro)

806722-005

(18)

Battery, 4-cell, 64-WHr, 4.21-AHr, Li-ion battery

808450-002

(19)

Bottom cover

840954-001

(20)

Service door

840959-001
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Display assembly subcomponents

Item

Component

(1)

Display bezel

(2)

Spare part number

For use only on computer models equipped with a webcam

840935-001

For use only on computer models not equipped with a webcam

840936-001

Display panel
15.6-in, FHD, UWVA, LED display panel

840941-001

15.6-in, UHD, UWVA, B LED display panel

840943-001

(3)

Display hinges (includes left and right hinges)

840937-001

(4)

Display Cable Kit

840938-001

(5)

Webcam module (includes double-sided adhesive)

840965-001

(6)

Antenna (left and right)

840940-001

(7)

Thermal board

840956-001

(8)

Display panel bracket (only spared with UHD displays; included in Bracket Kit, spare part
number 840966-001)

840966-001 (Bracket Kit)

(9)

Display enclosure
For use in FHD models

844836-001

For use in UHD models

925035-001

Display assembly subcomponents
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Bracket Kit

Item

20

Component

Spare part number

Bracket Kit

840966-001

(1)

EDP bracket

(2)

Display panel bracket, left

(3)

Display panel bracket, right

(4)

2nd SSD bracket

(5)

I/O support bracket
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Plastics Kit

Item

Component

Spare part number

Plastics Kit

840964-001

(1)

Fingerprint reader insert

(2)

Card reader insert

Plastics Kit

21

Miscellaneous parts
Component

Spare part number

AC adapter
150-W HP Smart adapter (non-PFC, 4.5-mm)

776620-001

65-W HP Smart adapter (PFC, 4.5-mm)

710412-001

Power cord (3-pin, black, 1.83 m):
Argentina

401300-001

Australia

213356-001

Brazil

438722-001

Denmark

213353-001

Europe (Austria, Belgium, Finland, France, Germany, the Netherlands, Norway and Sweden)

213350-001

India

404827-001

Israel

398063-001

Italy

213352-001

Japan

349756-001

North America

213349-001

People’s Republic of China

286497-001

South Africa

361240-001

South Korea

267836-001

Switzerland

213354-001

Taiwan

393313-001

Thailand

285096-001

United Kingdom and Singapore

213351-001

Power cord (3-pin, black, 1.0 m):
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Argentina

401300-007

Australia

213356-008

Brazil

438722-004

Denmark

213353-008

Europe (Austria, Belgium, Finland, France, Germany, the Netherlands, Norway and Sweden)

213350-009

India

404827-003

Israel

398063-003

Italy

213352-008

Japan

349756-002

North America

213349-009

People’s Republic of China

286497-008
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Component

Spare part number

South Africa

361240-002

South Korea

267836-008

Switzerland

213354-008

Taiwan

393313-003

Thailand

285096-006

United Kingdom and Singapore

213351-008

HP USB External DVD+RW Drive

747080-001

HP Elite USB-C Docking Station

844549-001

HP Thunderbolt 3 Docking Station

849784-001

HP Thunderbolt 3 power cable

855116-001

HP Professional Slim Top Load Case

703888-001

HP Business Top Load Case

718550-001

Fingerprint reader insert (for use in models without a fingerprint reader; included in Plastic Kit, spare
part number 840964-001)

840964-001 (Plastic Kit)

Card reader insert (included in Plastic Kit, spare part number 840964-001)

840964-001 (Plastic Kit)

HP Ultraslim Keyed Cable Lock

703372-001

HP USB-C to USB 3.0 adapter

814618-001

HP USB Type -A to USB Type C adapter
Screw Kit

840939-001

Mouse
HP USB laser

674318-001

HP Wireless

691922-001

HP Ultrathin Bluetooth Mouse

811730-001

Miscellaneous parts
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4

Removal and replacement procedures
preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screw driver

●

Magnetic screw driver

●

Phillips P0 and P1 screw drivers

●

Torx screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying
screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care
when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the
reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat
the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught
or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear
easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a storage device, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.
Before removing an optical drive, be sure that a disc is not in the drive and be sure that the optical drive tray is
closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a storage device or an optical drive, place it in a static-proof bag.
Avoid exposing an internal storage device to products that have magnetic fields, such as monitors
or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine
the degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many
cases, ESD contains enough power to alter device parameters or melt silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal
cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life
expectancy.

Grounding guidelines
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CAUTION: To prevent damage to the computer when you are removing or installing internal components,
observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Before touching an electronic component, discharge static electricity by using the guidelines described in this
section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
CAUTION:

A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity

Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from styrene foam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to avoid
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and
equipment.

●

Use conductive field service tools, such as cutters, screw drivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and styrene
foam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Grounding guidelines
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips
to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be
used at standing workstations and are compatible with most types of shoes or boots. On conductive
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance
between the operator and ground. To be effective, the conductive equipment must be worn in contact
with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastics

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Removal and replacement procedures for
Customer Self-Repair parts
NOTE: The Customer Self-Repair program is not available in all locations. Installing a part not supported by
the Customer Self-Repair program may void your warranty. Check your warranty to determine if Customer
Self-Repair is supported in your location.

Component replacement procedures
NOTE: Please read and follow the procedures described here to access and replace Customer Self-Repair
parts successfully.
NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag on the bottom of your computer. See Labels on page 14 for details.
This chapter provides removal and replacement procedures for Customer Self-Repair parts.
There are as many as 16 screws that must be removed, replaced, and/or loosened when servicing Customer
Self-Repair parts. Make special note of each screw size and location during removal and replacement.

Component replacement procedures
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Service door
Description

Spare part number

Service door

840959-001

Before removing the service door, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

Remove the service door:
1.

Position the computer upside down.

2.

Loosen the four captive Torx screws (1) that secure the door to the computer.

3.

Lift the door off the computer (2).

Reverse this procedure to install the service door.
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Bottom cover
Description

Spare part number

Bottom cover

840959-001

Before removing the bottom cover, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

Remove the bottom cover:
1.

Loosen the seven captive Torx screws (1) that secure the bottom cover to the computer.

2.

Lift the bottom cover off the computer (2).

Reverse this procedure to install the bottom cover.

Component replacement procedures
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Battery
Description

Spare part number

4-cell, 64-WHr, 4.21-AHr, Li-ion battery

808450-002

Before removing the battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

Remove the battery:
WARNING! To reduce potential safety issues, use only the user-replaceable battery provided with the
computer, a replacement battery provided by HP, or a compatible battery purchased from HP.
CAUTION: Removing a user-replaceable battery that is the sole power source for the computer can cause
loss of information. To prevent loss of information, save your work or shut down the computer through
Windows before removing the battery.
1.

Disconnect the battery cable from the system board (1).

2.

Remove the six Phillips PM2.5×4.0 screws (2) that secure the battery to the computer.

3.

Remove the battery from the computer (3).

Reverse this procedure to install the battery.
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Solid-state drive (M.2)
Description

Spare part number

1-TB, Z Turbo drive PCIe

840951-001

512-GB, Z Turbo Drive, PCIe

840950-001

512-GB, SATA-3, self-encrypting drive (SED), OPAL2, MLC

860756-001

512-GB, SATA-3, self-encrypting drive (SED), OPAL2, TLC

923709-001

512-GB, locked, for Proctor & Gamble

919662-001

512-GB, SATA-3, TLC

922236-001

256-GB, Z Turbo Drive, PCIe

840949-001

256-GB, SATA-3, self-encrypting drive (SED), OPAL2, TLC

930462-001

256-GB, SATA-3, TLC

922235-001

128-GB, TLC

846386-001

Solid-state drive bracket (included in Bracket Kit, spare part number 840966-001)

840966-001 (Bracket Kit)

Before removing the solid-state drive, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

Remove the solid-state drive:
1.

Remove the Phillips PM2.0×3.5 screw (1) that secures the solid-state drive to the system board.
NOTE: If the module springs up when the screw is removed, be sure to remove the module at the angle
dictated by the spring mechanism.
When installing the module, be sure to insert the module at the angle that it sits after the screw is
removed and the module springs up.

2.

Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.

Component replacement procedures
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Reverse this procedure to install the solid-state drive.
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WLAN module
Description

Spare part number

Intel Dual Band Wireless-AC 8260 3rd Gen Intel 802.11ac, Dual Band, 2x2 Wi-Fi + Bluetooth 4.2

806721-005

Intel Dual Band Wireless-AC 8260 3rd Gen Intel 802.11ac, Dual Band, 2x2 Wi-Fi + Bluetooth 4.2 (nonvPro)

806722-005

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in your
country or region. If you replace the module and then receive a warning message, remove the module to
restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Disconnect the battery (see Battery on page 32).

Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled “1”.
The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”.

2.

Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board. (The
WLAN module tilts up.)
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3.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, protective
sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Memory module
Description

Spare part number

For use with Core processors:
16 GB

820571-002

8 GB

820570-002

4 GB

820569-002

For use with Xeon processors:
16 GB, ECC

835886-002

8 GB, ECC

835887-002

Update BIOS before adding memory modules
Before adding new memory, make sure you update the computer to the latest BIOS.
CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may result in
various system problems.
To update BIOS:
1.

Navigate to www.hp.com.

2.

Click Support & Drivers > Drivers & Software.

3.

In the Enter a product name/number box, type the computer model information, and then click Search.

4.

Click the link for the computer model.

5.

Select the operating system, and then click Next.

6.

Under Step 2: Select a Download, click the BIOS link.

7.

Click the link for the most recent BIOS.

8.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Disconnect the battery (see Battery on page 32).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The memory module tilts up.)
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2.

Remove the memory module (2) by pulling the module away from the slot at an angle.

Reverse this procedure to install a memory module.
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RTC battery
Description

Spare part number

RTC battery (includes cable and double-sided adhesive)

840953-001

Before removing the RTC battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Disconnect the battery (see Battery on page 32).

Remove the RTC battery:
1.

Disconnect the RTC battery cable (1) from the system board.

2.

Detach the RTC battery (2) from the base enclosure. (The RTC battery is attached to the base enclosure
with double-sided adhesive.)

3.

Remove the RTC battery and cable.

Reverse this procedure to install the RTC battery.
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6

Removal and replacement procedures for
authorized service provider parts
CAUTION: Components described in this chapter should be accessed only by an authorized service provider.
Users who access these parts can damage the computer or void the warranty.

Component replacement procedures
There are as many as 74 screws that must be removed, replaced, and/or loosened when servicing the parts
described in this chapter. Make special note of each screw size and location during removal and replacement.

Thermal module
NOTE:

The thermal module spare part kit includes replacement thermal material.

Description

Spare part number

Thermal module for use only with models with discrete graphics memory

840960-001

Thermal module for use only with models with discrete graphics memory (4 + 4E)

900285-001

Thermal module for use only with models with UMA graphics memory

840961-001

Before removing the thermal module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Disconnect the battery (see Battery on page 32).

Remove the thermal module:
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1.

Disconnect the cable for each fan from the system board (1).

2.

Loosen the six captive screws (discrete models) or three captive screws (UMA models) in the middle of
the heat sink (between the fans) in the order indicated on the heat sink (2) and the two captive screws
from each fan (3).

3.

Remove the antennas from the routing path atop the left fan (4) and the display connector from the
routing path atop the right fan (4).
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4.

Remove the fan/heat sink assembly (5).
CAUTION:
the fans.

When lifting the heat sink out of the computer, be careful not to bend the arm that connects

Discrete models:

UMA models:

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan/heat sink assembly
and the system board components each time the fan/heat sink assembly is removed. Replacement thermal
material is included with the thermal module, processor, and system board spare part kits.
Discrete graphics models:
●

Various thermal pads are used on the system board components and the heat sink sections and that
service them. See the following image for thermal pad locations.
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UMA graphics models:
●

Various thermal pads are used on the system board components and the heat sink sections and that
service them. See the following image for thermal pad locations.

Reverse this procedure to install the thermal module.
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Fingerprint reader board
Description

Spare part number

Fingerprint reader board (includes bracket)

840952-001

Before removing the fingerprint reader board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

Remove the fingerprint reader board:
1.

Disconnect the cable from the system board (1).

2.

Lift the tape from atop the fingerprint reader (2).

3.

Remove the Phillips PM2.0×3.0 screw that secures the bracket to the computer (3).

4.

Slide the bracket downward to disengage it, and then lift the bracket off the fingerprint reader (4).

5.

Remove the fingerprint reader from the computer (5).

Reverse this procedure to install the fingerprint reader board.
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LED board
Description

Spare part number

LED board

840957-001

Before removing the LED board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

Remove the LED board:
1.

Remove the tape from atop the cable (1).

2.

Disconnect the cable from the system board (2).

3.

Remove the two Phillips PM2.0×2.0 broadhead screws (3) that secure the LED board to the computer.

4.

Remove the LED board (4).

Reverse this procedure to install the LED board.
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TouchPad
Description

Spare part number

TouchPad

840962-001

Before removing the TouchPad, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

Remove the TouchPad:
1.

Disconnect the cable from the system board (1).

2.

Remove the six Phillips PM2.0×2.0 screws (2) that secure the TouchPad to the top cover.

3.

Lift the TouchPad out of the computer (3).

Reverse this procedure to install the TouchPad.
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Display cable
Description

Spare part number

Display cable

840938-001

eDP bracket (included in Bracket Kit, spare part number 840966-001)

840966-001 (Bracket Kit)

Before removing the display cable, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Disconnect the battery (see Battery on page 32).

Remove the display cable:
1.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the display cable to the computer.

2.

Lift the eDP bracket from atop the connector (2).

3.

Disconnect the cable from the system board (3).

4.

Remove the cable from the clips along its routing path (4).

Reverse this procedure to install the display cable.
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System board
NOTE: The system board spare part kit includes battery connector bracket and replacement
thermal material.
All system boards use the following part numbers:
xxxxxx-001: Windows 7 or non-Windows operating systems
xxxxxx-601: Windows 10 operating system
Description

Spare part number

Intel Xeon E3-1545M processor

840934-xxx

Intel Xeon E3-1505M processor

840933-xxx

Intel Core i7-6820HQ processor and discrete graphics memory

840932-xxx

Intel Core i7-6820HQ processor and UMA graphics memory

840930-xxx

Intel Core i7-6700HQ processor and discrete graphics memory

840931-xxx

Intel Core i7-6700HQ processor and UMA graphics memory

840929-xxx

Intel Core i7-6440HQ processor and discrete graphics memory

900200-xxx

Intel Core i7-6440HQ processor and UMA graphics memory

913334-xxx

Intel Core i7-6300HQ processor and discrete graphics memory

863779-xxx

Intel Core i7-6300HQ processor and UMA graphics memory

913333-xxx

Before removing the system board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

7.

Remove the thermal module (see Thermal module on page 40).

8.

Remove the display cable (see Display cable on page 46).

NOTE: When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:
●

Solid-state drive (see Solid-state drive (M.2) on page 33)

●

WLAN module (see WLAN module on page 35)

●

Memory module (see Memory module on page 37)

Remove the system board:
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1.

Disconnect the following cables from the system board:
(1) Right speaker cable
(2) Fingerprint reader cable
(3) TouchPad cable
(4) LED board cable
(5) RTC battery cable
(6) Left speaker cable
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2.

Remove the seven Phillips PM2.5×4.0 screws (1).

3.

Remove the two Phillips PM2.5×4.0 shoulder screws (2).

4.

Lift in the middle of the board until the connectors disengage from the left side of the computer (1).
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5.

Disconnect the keyboard cable from the bottom of the system board (2).

6.

Remove the system board from the computer (3).
CAUTION: When you lift the system board from the computer, be careful not to damage or break the
narrow sections of the board.

Reverse this procedure to install the system board.

Component replacement procedures

49

I/O support bracket
Description

Spare part number

I/O support bracket (included in Bracket Kit, spare part number 840966-001)

840966-001 (Bracket Kit)

Before removing the I/O support bracket, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

7.

Remove the thermal module (see Thermal module on page 40).

8.

Remove the display cable (see Display cable on page 46).

9.

Remove the solid-state drive (see Solid-state drive (M.2) on page 33).

10. Remove the WLAN module (see WLAN module on page 35).
11. Remove the system board (see System board on page 47).
Remove the I/O support bracket:
▲

Lift the I/O support bracket straight up and off the system board.

Reverse this procedure to install the I/O support bracket.
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Speakers
Description

Spare part number

Speakers (includes cable)

840958-001

Before removing the speakers, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

7.

Remove the thermal module (see Thermal module on page 40).

8.

Remove the display cable (see Display cable on page 46).

9.

Remove the solid-state drive (see Solid-state drive (M.2) on page 33).

10. Remove the WLAN module (see WLAN module on page 35).
11. Remove the system board (see System board on page 47).
Remove the speakers:
1.

Remove the four Phillips PM2.0×3.0 broadhead screws (1) that secure the speakers to the computer.

2.

Remove the speakers (2).

Reverse this procedure to install the speakers.
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NOTE: When installing the speakers, make sure the rubber grommets around the screws are correctly
installed.

Keyboard
For use in country or region

Spare part
number

For use in country or region

For use in Belgium

841681-A41

For use in Northwest Africa

841681-FP1

For use in Brazil

841681-201

For use in Norway

841681-091

For use in Bulgaria

841681-261

For use in Portugal

841681-131

For use in Canada

841681-DB1

For use in Romania

841681-271

For use in the Czech Republic and Slovakia

841681-FL1

For use in Russia

841681-251

For use in Denmark

841681-081

For use in Saudi Arabia

841681-171

For use in France

841681-051

For use in Slovenia

841681-BA1

For use in Germany

841681-041

For use in South Korea

841681-AD1

For use in Greece

841681-151

For use in Spain

841681-071

For use in Hungary

841681-211

For use in Sweden and Finland

841681-B71

Spare part number

Keyboard with backlight:

Before removing the keyboard, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

7.

Remove the thermal module (see Thermal module on page 40).

8.

Remove the display cable (see Display cable on page 46).

9.

Remove the solid-state drive (see Solid-state drive (M.2) on page 33).

10. Remove the WLAN module (see WLAN module on page 35).
11. Remove the system board (see System board on page 47).
Remove the keyboard:
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1.

Partially open the computer.

2.

Rest and secure the computer on its left side.

3.

Insert a thin tool into the keyboard release hole, and then press on the back of the keyboard until the
keyboard disengages from the computer (1).
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4.

Remove the keyboard (2).

Reverse this procedure to install the keyboard.
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Display assembly
NOTE: The DreamColor display assembly is spared as a whole unit assembly only. The LED display assembly
is spared at the subcomponent level only. For more LED display assembly spare part information, see the
individual removal subsections.
Description

Spare part number

15.6-in, UHD, UWVA, DreamColor display assembly not equipped with a webcam

840945-001

15.6-in, UHD, UWVA, DreamColor display assembly equipped with a webcam

840946-001

15.6-in, FHD, UWVA display assembly with a touch screen

840947-001

To remove the display assembly and access the LED display assembly subcomponents, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service door (see Service door on page 30).

5.

Remove the bottom cover (see Bottom cover on page 31).

6.

Remove the battery (see Battery on page 32).

7.

Remove the thermal module (see Thermal module on page 40).

8.

Remove the display cable (see Display cable on page 46).

9.

Remove the solid-state drive (see Solid-state drive (M.2) on page 33).

10. Remove the WLAN module (see WLAN module on page 35).
11. Remove the system board (see System board on page 47).
Remove the display assembly:
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1.

Remove the three Phillips PM2.5×4.0 screws (1) that secure each hinge to the computer.

2.

Open the computer as far as possible.
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3.

Separate the display from the computer (2).

4.

If it is necessary to replace the display bezel or any of the LED display assembly subcomponents:
a.

Use a plastic tool to disengage the bezel starting at the top (1), left and right sides (2), and bottom
(3).

Component replacement procedures

55

b.

Remove the display bezel (4).
The display bezel is available using the following spare part numbers:
840935-001: Models with a webcam
840936-001: Models without a webcam

5.

If it is necessary to replace the display panel:
a.
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Remove the four Phillips PM2.0×2.0 screws that secure the display panel to the display enclosure.
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CAUTION: Before turning the display panel upside down, make sure the work surface is clear of
tools, screws, and any other foreign objects. Failure to follow this caution can result in damage to
the display panel.
b.

Lift the top edge of the display panel (1) and swing it up and forward until it rests upside down in
front of the display enclosure.

c.

Remove the display cable from the clip (2).

d.

Lift the tape (3), and then disconnect the display panel cable (4) from the display panel.

e.

Remove the display panel.
The display panel is available using spare part numbers 840941-001 (15.6-in, FHD, UWVA, LED
display panel) and 840943-001 (15.6-in, UHD, UWVA, LED B display panel).

6.

If it is necessary to replace the webcam module or microphone module:
NOTE: The webcam module and microphone module are similar in appearance and installed in the
same location. The removal procedures are the same for both modules.
CAUTION: Handle the module with caution. This module has a thin profile and is susceptible to damage
when not handled carefully.
a.

Detach the webcam or microphone module (1) from the display enclosure. (The module is attached
to the display enclosure with double-sided adhesive.)
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b.

Disconnect the module cable (2) from the module.

c.

Remove the module.
The webcam module is available using spare part number 840965-001.
The microphone module is available using spare part number 840955-001.

7.

If it is necessary to replace the thermal board:
a.

Disconnect the thermal board cable (1) from the board.

b.

Using a flat tool, pry the board loose (2), and then remove the board (3) from the display
enclosure. (The thermal board is attached to the display enclosure with double-sided adhesive.)

c.

Remove the thermal board.
The thermal board is available using spare part number 840956-001.

8.

If it is necessary to replace the display hinges:
a.
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Remove the three Torx T8M2.5×4.0 screws (1) that secure each display hinge to the display panel.
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b.

Remove the display hinges (2).
The display hinges are available using spare part number 840937-001 and include the left and
right hinges.

9.

(UHD models only) If it is necessary to replace the display brackets:
▲

Lift the bottom bracket (1) and top bracket (2) out of the display enclosure.
Display panel brackets are available in the Bracket Kit using spare part number 840966-001.
NOTE: The display brackets can only be removed from UHD panels.

10. If it is necessary to replace the wireless antennas:
a.

Remove the cables from the routing path on the bottom-right corner of the display (1).

b.

Remove the two Phillips PM2.0×2.0 screws (2) that secure the plastic holder to the bottom of the
display.
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c.

Peel the antennas off the display (3).
The antennas are available using spare part number 840940-001.

11. If it is necessary to replace the display cable:
a.

Remove the display cable and webcam cable from the routing path along the bottom and left side
of the display enclosure (1).

b.

Remove the display cable from the display enclosure (2).
The antennas are available using spare part number 840938-001.

Reverse this procedure to reassemble and install the display assembly.
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Top cover
Description

Spare part number

Top cover

840636-001

The top cover spare remains after removing all other spare parts.
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7

Troubleshooting guide
This chapter is primarily focused on troubleshooting HP Mobile Workstations and HP Notebooks. The
information is provided so that you can solve problems yourself or at least narrow down what may be causing
the problem. Based on some of the most common symptoms, this chapter helps to identify logical steps and
available resources or tools for resolving an issue. HP recommends that you follow the instructions carefully,
observe safety precautions, and note any observations or results. Capturing this information may help
identify and resolve the problem faster.
WARNING!

To reduce the risk of electric shock or damage to the equipment:

●

Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

●

Plug the power cord into a grounded (earthed) outlet that is easily accessible at all times.

●

Disconnect power from the equipment by unplugging the power cord from the AC outlet.

●

Before disassembling notebooks, always disconnect power and remove the battery.

CAUTION: Static electricity can damage the electronic components of the computer. To prevent damage to
the computer, carefully observe the electrostatic discharge precautions.
●

Discharge static electricity by briefly touching a grounded metal object before you begin.

●

Work on a static-free mat.

●

Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body to
the ground.

●

Create a common ground for the equipment you are working on by connecting the static-free mat, static
strap, and peripheral units to that piece of equipment.

●

Refer to the Electrostatic Discharge Section of the Maintenance & Service Guide for more information.

CAUTION: The computer includes customer self-repair parts and parts that should only be accessed by an
authorized service provider. See the chapter titled "Removal and replacement procedures for Customer SelfRepair parts," for details. Accessing parts described in the chapter titled "Removal and replacement
procedures for authorized service provider only parts" can damage the computer or void the computer
warranty.
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Resources
HP Resource Tool

Description

Link

HP Elite Support

Provides live HP Premium support (available 24/7) to
Elite computers.

http://www8.hp.com/us/en/ads/eliteproducts/overview.html

HP Support Center

Provides important support, such as warranty,
support cases, drivers, Customer Advisories,
Customer and Security Bulletins, and Product Change
Notices.

http://h20565.www2.hp.com/portal/site/
hpsc

HP Troubleshooting Support page

Provides troubleshooting information for your
specific HP computer.

http://www8.hp.com/us/en/
troubleshooting.html

Subscribers Choice

Allows you to sign up for HP product updates.

http://www8.hp.com/us/en/subscribe/

HP Support Forums

Provide discussions about HP products and issues.

http://h30434.www3.hp.com/psg/

Service Access Workbench (SAW)
(Available for technicians and
Business Partners only)

Provides navigable content intended for use by
internal and outsourced call center staff and can be a
resource for support and product division
professionals.

http://sawpro.atlanta.hp.com

Vendors’ web sites

Provide additional information for associated
components such as Intel (processor, WLAN),
Microsoft (Windows 7/8/10), AMD/NVidia (GPU), and
so on.

http://www.intel.com
http://www.microsoft.com
http://www.amd.com
http://www.nvidia.com

General troubleshooting steps
A basic logic should be used when troubleshooting computer issues. This section will help you become
familiar with troubleshooting methodology and efficiently resolve problems. Proceed through the steps in the
following table until the issue is resolved, and then move on to the next step that is relevant to the issue. For
example, if you resolve a memory issue using the HP PC Diagnostics (UEFI) tool in step 6, you can then move
on to step 10 to reseat the memory into its memory slot.
NOTE:
apply.

General troubleshooting steps do not have to be followed in a specific order if an issue does not

Table 7-1 Troubleshooting methodology and general troubleshooting steps
Identify issue

Analyze issue

Resolve issue

Verify solution

1. Understand the issue
on page 64

5. Remove or uninstall recently
added hardware, software
on page 67

8. Hard reset on page 76

Verify solution
on page 80

2. Examine the environment
on page 66
3. Perform a visual inspection
of hardware on page 67
4. Update BIOS and drivers
on page 67

6. HP Hardware Diagnostics and
Tools on page 68
7. Status lights, blinking light
codes, troubleshooting lights,
and POST error messages
on page 72

9. Soft reset (Default Settings)
on page 77
10. Reseat cables and connections
on page 77
11. Test with minimum configuration
on page 78
12. Test with verified working
configuration (hardware and/or operating
system) on page 79
13. Replace the system board on page 79

Resources
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Identify the issue
1. Understand the issue
It is important to understand the issue that occurred, including related symptoms. It helps to understand the
basic computer boot-up sequence as well as the failure itself. The boot-up sequence and associated failures
are described below.
Boot up sequence
The computer performs several steps after you press the power button or restart the computer.
It is important to understand where in the boot-up sequence the symptoms occur. The following table lists
the phases of the boot-up sequence and explains the symptoms that may occur in each phase. For example, a
blue screen error (BSOD) often occurs during the performance phase.
Table 7-2 Boot-up sequence
Power-on

After power button is pressed, the computer boots after all internal power rails (i.e., 5V, 3.3V) are stable.
Confirm that power lights are on fan is spinning.
Next step: If the computer experiences a power-on issue, see “Verify Power Good (Troubleshooting) lights” in
No Power on page 82.
Common issues: all lights are off; troubleshooting lights are on; does not boot; video is absent.

POST (UEFI/BIOS)

Power-On Self-Test (POST) verifies that hardware components (processor, storage device, memory, etc.) are
functional. When POST is complete, the HP logo displays briefly and then disappears.
If there are errors, the computer may exhibit blinking lights and POST error messages
Common issues: lights blink, error message appears, hangs.

Performance
(operating system)

System boots to operating system, and Windows logo screen appears..
Common issues: hangs (lock up/freezes), blue screen, video distorted, driver conflict, slow performance,
display issue (dead pixel), I/O issue (no speaker sound), wireless/audio unavailable, noise.
See Analyze the issue on page 67 table below for detailed troubleshooting information).

Failure classification
Failure classification is a breakdown of different types of failures and symptoms that could occur during the
boot-up sequence. Table 3 and table 4 represent the failure classification for common notebook failures.
Table 3 categorizes failures by the boot-up sequence.
1.

Power-on: Common issues are No Power, Recycle/Reboot, etc.

2.

POST: Common issues are No Boot (have power), Light Flash or Diagnostics Error.

3.

Performance: Common issues are Intermittent Loss of Power, Blue Screen, Hang, etc. In many cases,
issues may be identified and associated with a particular hardware (i.e., display, storage).
Table 4 categorizes failures by hardware.
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4.

Display

5.

I/O devices (Input/Output)

6.

Storage

7.

Mechanical
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A single symptom can be listed under different groups. For example, No Video can belong to (1) Power-on or
(4) Display; but Flickering when powered should be listed in (4) Display. Or, in another example, a blue screen
can be caused by a driver conflict in Performance (4), but it can also be caused by a defective storage device
under (6) Storage. Therefore, failures that share similar symptoms are noted..
If possible, make a record of the failure symptom, the phase of the boot-up sequence where the failure
occurs, and the most likely location in the failure tree (Table 7-3 Failure classification by boot-up sequence
on page 65 and Table 7-4 Failure classification by hardware devices and mechanical on page 66). This will
help isolate the issue and indicate the next steps. For example, when the computer is running the operating
system, it may experience an issue with (4) Display, (5) I/O devices (keyboard, wireless, and so on), (6)
Storage, or (7) Mechanical components (stuck buttons, thermal shutdown, and so on).
NOTE: “Uncategorized” is used if an issue found is not listed. For example, Bluetooth is offered on certain
hardware configurations; therefore, a Bluetooth issue can be classified under “I/O Device” if needed.
Failure classification by boot-up sequence
Table 7-3 Failure classification by boot-up sequence
1. Power-on

2. POST

3. Performance

1.

No Power on page 82

1.

1.

Intermittent shutdown on page 92a

2.

Intermittent power-on, shutdown,
reboot on page 84a

No video (with power)
on page 88

2.

2.

Blinking lights on page 89

Blue screen (BSOD) error on page 117b

AC adapter issue on page 85

3.

Freeze at Windows Logo (hang/lockup)
on page 95

4.

Battery not recognized, not charging
on page 86

Diagnostics error messages
on page 90

3.

3.

4.

BIOS password on page 91

4.

Electromagnetic Interference (EMI)
on page 96

5.

No wake up on page 97

6.

Unresponsive on page 98

7.

Slow performance on page 98c

8.

HP Smart Adapter warning message
on page 99

9.

Incorrect time and date on page 99

5.

Battery discharges too fast
on page 87

6.

Burnt smell on page 88

a,b,c

similar symptoms
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Failure classification by hardware devices and mechanical
Table 7-4 Failure classification by hardware devices and mechanical
4. Display

5. I/O devices

6. Storage

7. Mechanical

1.

Display anomalies
on page 100

1.

Keyboard on page 106

1.

1.

2.

Dead pixel on page 102

Keyboard point stick
on page 107

Fan error message - 90B
on page 119

2.

Hard drive/solid-state
drive not recognized
on page 116

2.

2.

No boot to operating
system (no read/write
error) on page 116

Noise (sound)
on page 120

3.

Fan runs constantly
on page 121

3.

Read-write error
on page 117

4.

HP Thermal Monitor
on page 71

4.

Slow performance
on page 98c

5.

Stuck power button
on page 122

5.

Blue screen (BSOD) error
on page 117b

6.

Noisy hard drive
on page 118

3.
4.

No video (internal)
on page 102d

3.

No video (external)
on page 103d

4.

TouchPad on page 108

5.

Network Connectivity
Ethernet (RJ-45 jack)
on page 108

5.

DisplayPort/VGA
on page 103

6.

HDMI on page 103

7.

No or bad external video
via docking on page 104

8.

Incorrect or missing color/
distorted image
on page 104

9.

Touch screen
on page 105

Keyboard backlight
on page 107

6.

Network connectivity
wireless (WLAN)
on page 109

7.

USB on page 110

8.

Smart card reader
on page 112

9.

Speaker, headphone audio issues on page 113

10. Thunderbolt (TB)
on page 114
b,c,d

similar symptoms

2. Examine the environment
It is important to examine the computer’s environment. If you can quickly identify the cause of the issue,
fewer resolution steps may be needed. Perform the following environment inspections:
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●

Check all cables and connections to be sure that there are no loose connections.

●

Confirm that power sources are good, such as wall power type/adapter (110V/220V ac), power strip. Test
with a verified working AC outlet.

●

Check for compatibility issues between the computer and third-party devices, peripherals, noncertified
devices, incompatible hardware (i.e., Mac OS device). Incompatibility can result in blue screen errors,
improper operation, and so on.

●

Isolate the computer from sources of electromagnetic interference (EMI), such as cell phones, 2-way
radios, floor mats, fans (and other electronic motors). EMI may contribute to a display freeze issue or
lock-up.
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3. Perform a visual inspection of hardware
It is important to do a visual inspection of the hardware itself. Perform physical inspection of the computer:
●

Look for abnormalities such as a cracked display, dented battery, broken latches for battery bay,
keyboard key caps popped out, dust over connectors, liquid spill over keyboard, etc.

●

Look for signs of drop, movement, or vibration that may cause internal and external loose connections.

4. Update BIOS and drivers
IMPORTANT:

Whenever possible, update to the latest BIOS, firmware, and drivers before troubleshooting.

Note that some customer company policies prohibit updates. Check your company policy before taking action.
The updates may include fixes for your computer issues, and they may also enhance system performance. HP
continually improves the update process to make it easier. The BIOS update can be done locally through a
manual process, through an automatic installation, or through a remote installation on multiple units.
Manually updating BIOS and drivers
●

See the Computer Setup chapters to manually update BIOS and drivers.

●

Refer to specific BIOS update installation instructions that accompany the download.

Remotely deploying BIOS and drivers
Instead of manually searching for and downloading each SoftPaq, users and IT personnel can use two tools to
identify and download all appropriate SoftPaqs for the selected HP models.
●

HP SoftPaq Download Manager (SDM) is a software tool designed to streamline the download,
extraction, and installation process of SoftPaqs, including BIOS and drivers.

●

HP System Software Manager (SSM) is a software tool designed to simplify the deployment of SoftPaqs
to HP computers.

Analyze the issue
5. Remove or uninstall recently added hardware, software
HP has designed this computer and validated it using a full-range hardware and software qualification matrix.
If an issue appears to have started recently, it may be related to the recent addition of hardware or software.
A good method to determine the root cause is to remove recently added components or uninstall applications
one at a time and restart the computer when necessary.
IMPORTANT: After you have completed the process of uninstalling hardware or software and are ready to
reinstall, when installing a new device be sure that it is seated properly and all cables are correctly connected.
After installing the device, restart the computer and make sure the new device is powered on. In addition, if
the new device is a root cause of a problem, it could cause a conflict in drivers or incompatibility issues with
other programs installed. For any new hardware you have added, be sure to install the latest drivers available
from the device vendor website.
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6. HP Hardware Diagnostics and Tools
HP offers different diagnostics and tools to diagnose hardware failure. This section describes how to use
some of these tools. Make sure to check for the latest versions before use.
HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic
tests to determine whether the computer hardware is functioning properly. The HP PC Hardware Diagnostics
(UEFI) tool is built within BIOS (basic memory and storage device diagnostics only), or within new storage
devices themselves. These drives contain more advanced versions of the diagnostic tool than the BIOS-based
version.
In addition, for HP authorized service partners and IT professionals who need to support a mixed environment
of older and newer HP/Compaq PCs, the HP PC Diagnostics 3-in-1 USB Key is a diagnostic tool that supports a
wide range of HP Desktop and Notebook computers.
The tool runs outside the operating system so that it can isolate hardware failures from issues that are
caused by the operating system or other software components. In reality, many problems can be determined
using this tool if the issue is a defective part or a loose connection (i.e., reseating keyboard cable after the
tool reports a keyboard error).
The tool has three major functions:
●

System Tests - Check the computer’s hardware to assure everything is functioning properly. If your
system won’t boot into Windows, try the Quick System Test. For more comprehensive testing, use the
Extensive System Test option. If the System Test did not detect a hardware problem, continue with the
Component Tests.

●

Component Tests – Focus on selected hardware components in your computer.

●

Firmware Management – Update your computer’s BIOS to the latest version (available separately) or roll
back to a previous version.

To start HP PC Hardware Diagnostics (UEFI):
1.
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Turn on or restart the computer, quickly press the esc button on the computer, and then press F2. The
BIOS searches three places for the diagnostic tools, in the following order:
a.

Connected USB drive

b.

Storage device

c.

BIOS
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2.

When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test you
want to run, and then follow the on-screen instructions.
Screen shot appearance may vary.

NOTE:

Users should utilize this tool, especially when the computer cannot boot to Windows.

NOTE: If a component fails a test, write down the information so it is available when contacting support.
The information is also available in Test Logs on the Main Menu.
For more information, see the chapter titled “Using HP PC Hardware Diagnostics (UEFI).”
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HP Support Assistant (HPSA)
HP Support Assistant (HPSA) helps you maintain peak performance and resolve problems through automatic
updates, built-in diagnostics, and a variety of assistance options. HPSA is preinstalled on every new HP PC
with Windows 7, Windows 8, or Windows 10. HP is continually improving this tool. Please verify the latest
version is installed to receive the most benefit. For more information, see HP Support Assistant.
NOTE: HPSA can be used only if the computer boots into Windows. If the computer does not boot into
Windows, use HP PC Hardware Diagnostics (UEFI) instead.
HPSA also integrates diagnostics and tools that help resolve issues. See example screen shots as follows.
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HP BIOS Configuration Utility (BCU)
HP BCU is a free utility that captures the BIOS settings and their values. This tool provides a text file of the
computer’s BIOS configuration. This can help identify any settings that may be contributing to an issue.
In some cases, it may help to compare this BIOS text file to the default settings of the computer.
For more information, see the HP BIOS Configuration Utility (BCU) User guide.
NOTE: HP recommends that you reset BIOS before trying BCU. Resetting the BIOS is always available and
relatively quick to try, whereas BCU takes extra time and effort.
HP Image Diagnostic Tool
Available to HP Authorized Support Partners (ASPs) and users from the HP public ftp site, this tool collects
information about the current state of the computer, including product serial number, platform and BIOS
information, and information about user-installed software and hardware components. HP encourages you to
review the report before sending it to support. The report may assist you with diagnostics and solutions to
problems you encounter.
HP Thermal Monitor
NOTE:

Available only to authorized service providers/technicians.

Available only for HP internal use, HP Thermal Monitor can be used to stress the processor and GPU and
monitor the temperature values of various components in the system. The components that are currently
monitored include the processor, GPU, ACPI thermal zones, storage device, and battery. The tool reads the
temperatures of the components, logs the data, and helps to determine whether the computer would
overheat in the event of thermal shutdown, fan spinning loud, etc.
Non HP diagnostics tools
Windows-to-Go USB
Windows-To-Go USB is a Microsoft-based tool for Enterprise editions of Windows that can help in
troubleshooting. You can find a process online about how to create a live Windows USB drive. For more
information, see Windows To Go: Feature Overview.
Intel Processor Diagnostic Tool
Determine what processor is in your computer and verify the processor operating frequency. The tool also
tests specific processor features and performs a stress test on the processor. For more information, see
http://www.intel.com/support/processors/sb/CS-031726.htm?iid=subhdr+tools_procdiagtool.
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7. Status lights, blinking light codes, troubleshooting lights, and POST error messages
Carefully observe any behavior the computer may be exhibiting: status lights, blinking lights, and POST error
messages during boot. It is important to understand what these indicators mean.
Status lights
See the chapter titled “External Component Identification” for light locations. The following table describes
basic lights on the computer.
Component

Description

Power button

When the computer is off, press the button to turn on the computer.
When the computer is on, press the button briefly to initiate Sleep (Windows) or Suspend
(Linux).
When the computer is in the Sleep state, press the button briefly to exit Sleep (Windows) or
Suspend (Linux).
When the computer is in Hibernation, press the button briefly to exit Hibernation.
CAUTION: Pressing and holding down the power button results in the loss of unsaved
information.
If the computer has stopped responding and operating system shutdown procedures are
ineffective, press and hold the power button.

Front power light

On: The computer is on.
Blinking: The computer is in the Sleep state.
Off: The computer is off.

Front AC adapter and battery light

White: The computer is connected to external power and the battery is charged from 90 to
99 percent.
Amber: The computer is connected to external power and the battery is charged from 0 to 90
percent.
Blinking amber: A battery that is the only available power source has reached a low battery
level. When the battery reaches a critical battery level, the battery light begins blinking
rapidly. By default, the critical battery level is defined in Power Options as 5%.
Off: The battery is fully charged.

Front storage device light

Blinking white: The storage device is being accessed.
Amber: HP 3D DriveGuard has temporarily parked the storage device.

Rear AC adapter light

White: The computer is connected to external power.
Off: The computer is not connected to external power.
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Interpreting system validation diagnostic front panel LEDs and audible codes
During the system validation phase that occurs at system startup, the BIOS validates the functionality of the
following subsystems and conditions:
●

AC adapter

●

System board power

●

Processor failure

●

BIOS corruption

●

Memory failure

●

Graphics failure

●

System board failure

●

BIOS authentication failure

If an error is detected, specific patterns of long and short blinks, accompanied by long and short beeps (where
applicable) are used to identify the error. These patterns will make up a two part code:
●

Major – the category of the error

●

Minor – the specific error within the category

NOTE:

Single beep/blink codes are not used.

Number of long beeps/blinks

Error category

1

Not used

2

BIOS

3

Hardware

4

Thermal

5

System board

Patterns of blink/beep codes are determined by using the following parameters:
●

1 second pause occurs after the last major blink.

●

2 second pause occurs after the last minor blink.

●

Beep error code sequences occur for the first 5 iterations of the pattern and then stop.

●

Blink error code sequences continue until the computer is unplugged or the power button is pressed.

NOTE:

Not all diagnostic lights and audible codes are available on all models.

The red LED blinks to represent the major error category (long blinks). The white LED blinks to represent the
minor error category (short blinks). For example, ‘2.3’ indicates 2 long red blinks and 3 short white blinks to
communicate the processor is not detected. CAP/NUM Blink = 2 indicates CAP/NUM will blink 2 cycles, each
cycle has one 2.3 sequence.
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Component
tested

Major/
minor
code

BIOS

Hardware

System board

Caps
Lock/Num
Lock LED

Error condition

Action

2.2

The main area (DXE) of BIOS has
become corrupted and there is no
recovery binary image available

CAP/NUM Blink
=2

Contact service for system board replacement.

2.3

The embedded controller policy
requires the user to enter a key
sequence (SureStart 2.0)

CAP/NUM Blink
=8

Perform SureStart manual recovery if boot
block: Up Arrow + Down Arrow + ESC.

2.4

The embedded controller is
recovering the boot block or DXE.

3.2

The embedded controller has timed
out waiting for BIOS to return from
memory initialization

CAP/NUM Blink
=3

Reseat the memory modules. If the issue
persists, try replacing the memory modules.
Possible RAM or system board failure.

3.3

The embedded controller has timed
out waiting for BIOS to return from
graphics initialization

CAP/NUM Blink
=4

If the system has an MXM module, try a
different MXM module. Otherwise, the board
most likely needs to be replaced.

3.4

The system board displays a power
failure (crowbar)

CAP/NUM Blink
=5

Check power cable connections, or verify that
any external power adapter has sufficient
capacity for system.

5.2

The embedded controller cannot find
valid firmware

CAP/NUM Blink
= 7 (2 BB
failure)
Battery LED
Blinking = 1 Hz
(3 B failure)

Contact service for system board replacement.

5.3

The embedded controller has timed
out waiting for the BIOS

CAP/NUM Blink
=1

Contact service for system board replacement.

Battery LED
White and
Amber
blinking

Wait for DXE recovery to complete.

POST error messages
The Power-On Self-Test (POST) is a series of diagnostic tests that runs automatically when the computer is
powered on. If the POST encounters a problem, visual error messages are displayed before the operating
system starts. POST checks the following items to ensure that the computer system is functioning properly:
●

Memory

●

Processors

●

BIOS

●

Mass storage devices

●

Fans

The following table describes errors encountered during HP PC Hardware Diagnostics (UEFI).
Table 7-5 System diagnostics failure codes and user actions
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Test description

Failure description

Error
code

Suggested user actions

Startup Test

Memory module

200

Attempt to reseat the memory module and then repeat the test.
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Table 7-5 System diagnostics failure codes and user actions (continued)
See the support document titled Overview of How to
Troubleshoot Problems When a Computer Does Not Start Up or
Boot Properly for details on troubleshooting issues related to the
memory module.
Startup Test

Hard Disk 1 SMART

301

Attempt to reseat the storage device and repeat the test. The
storage device may have failed.

Boot Device Manager

Boot device not found

3F0

Reset BIOS. Then reseat the storage device and repeat the test.

BIOS Recovery

BIOS Recovery Occurred

500

This message indicates that BIOS recovery was completed
successfully. No further action is required.

BIOS Application

BIOS Application Error

501

The BIOS installation may have become corrupted. Download the
latest version of the BIOS and install it.
If reinstalling the BIOS fails, contact support for further
assistance.

CMOS Recovery

CMOS Recovery Occurred

502

This message indicates that CMOS recovery was completed
successfully. No further action is required.

Battery Check

Primary Battery Replace

601

This message indicates that the primary battery has very low
capacity. See Checking the Status of the Battery for details on
using the HP Support Assistant to verify the battery capacity and,
if necessary, order a replacement.

Wireless Modules

Not installed or responding

701

Reseat the wireless LAN adapter module and antennas.
Because seating or reseating a wireless LAN adapter is unique to
each computer model, see the WLAN module removal section in
the removal and replacement chapter for further details.
Contact support if third-party wireless adapters are installed in
the computer.

Fan

Fan not operating correctly

90B

The system fan may be malfunctioning. Replace the fan.

Power Good (Troubleshooting) lights
HP has added troubleshooting power lights to ZBook G3 Mobile Workstations (Studio, ZBook 15, and ZBook
17) to help troubleshoot power-on issues. The lights indicate when the system board power rails are unstable
and/or the system needs a hardware reset.

These lights should be visible after removing the service door or bottom
cover. Consult with support for platform-specific locations of the lights.

●

Troubleshooting LEDs diagram

Example: System board is good. Lights that turn on briefly (< 1 second) and immediately turn off indicate
normal function. In this case, system (3.3V), power good (3.3V), and system reset (3.3V) are all good and
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troubleshooting lights should not be lit. However, other external lights should be lit as normal
afterward.

●

Troubleshooting lights

External lights

Action

Note

Off

On

Do not replace system board

No power-on issue

On

Off

Replace board

Power-on issue

Example: System board needs replacement. When (1) system 3.3V exists, but one power rail is bad then
(2) power good is low (0V), and troubleshooting lights will turn on.
After you press the system power button, troubleshooting lights will turn on for 5 seconds and turn
off. The system external lights will not light up. Follow general troubleshooting steps (i.e., remove
recently added hardware, test with minimum configuration, etc.) prior to replacing the system board.

Resolve the issue
8. Hard reset
A hard reset (or forced reset) erases all information in the computer's memory and may restore functionality.
Resetting the computer forces the system to clear and reestablish the connections between the BIOS and the
hardware.
Performing a hard reset might fix the following common conditions:
●

Windows stops responding.

●

Computer stops before Windows loads, indicated by incomplete boot-up, blinking cursor on a black
background, and errors relating to operating system not found or a missing drive.

●

Display suddenly goes blank and stays blank.

●

Software freezes.

●

Keyboard stops responding.

●

The computer does not exit Sleep or Suspend state.

●

An external device stops responding. Turn off the power to that device in addition to performing the
steps in this document.

Before performing a hard reset, you must disconnect or remove all peripheral devices. You should start and
test the computer by itself, and if the problem is not resolved, reconnect one peripheral device at a time. To
resolve the startup or operational problem, run HP Support Assistant, or manually install all updated drivers
from Microsoft and HP.
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Before beginning, turn the computer over and look for a battery compartment door (service door). For 2015
platforms, the battery is considered removable but not accessible. See the battery section for how to remove/
unplug the battery.
To perform a hard reset on a computer with a sealed or non removable battery, use the following steps:
1.

Turn off the computer.

2.

Remove the computer from any port replicator or docking station.

3.

Disconnect all external connected peripheral devices such as USB storage devices, external displays, and
printers.

4.

Unplug the AC adapter from the computer.

5.

Press and hold the power button for at least 15 seconds to drain residual power.

6.

Plug the AC adapter back into the computer, but do not connect any of the peripheral devices.

7.

Press the power button to turn on the computer.

8.

If a startup menu appears, use the arrow keys to select Start Windows Normally, and then press the
Enter key.

9.

After reconnecting each of the peripheral devices, run Windows Update and HP Support Assistant to
update all device drivers.

Clear CMOS
CMOS refers to the battery-powered, semiconductor chip located on computer's system board. Notebooks
store low-level settings like the system time and hardware settings in CMOS. Sometimes it is necessary to
clear CMOS, which requires removing and reinserting the 3V RTC battery for a short period of time (a few
minutes before reinserting), in addition to removing the AC adapter and battery.
NOTE: Clearing the CMOS should only be performed for troubleshooting purposes. There is no reason to
clear CMOS if the computer is working properly.
The notebook service door must be removed to access the CMOS battery. See the RTC battery replacement
section for the battery removal/replacement.

9. Soft reset (Default Settings)
NOTE: Some company policies prohibit updates or changes. Check whether the computer has custom BIOS
settings before taking action.
If your computer is having issues booting, has errors during boot, is running into issues after adding
hardware, or you are having other abnormal system behaviors that cannot be resolved through any other
methods (i.e., hard reset), it may be necessary to reset the system BIOS to default settings.
To load BIOS to default settings: Reboot the computer, and then press F10 > Main > Restore defaults. For
more information, see the BIOS F10 Setup technical white paper at http://support.hp.com, enter your
computer model, and then go to Manuals > White papers > HP PC BIOS F10 Setup Guide.

10. Reseat cables and connections
NOTE: Before disassembling the computer to reseat cables and connections, always disconnect power and
remove the battery or disconnect a non removable battery.
Many problems are caused by improper connections or loose connections due to abnormal movement and
vibration. See Cable management on page 135 and Connector types on page 136 for suggested cable
management practices when removing and installing components.
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You can access and reseat connections for Customer Self-Repair (CSR) parts (see the “Removal and
replacement procedures for Customer Self-Repair parts” chapter for details). Examples of reseating hardware
include:
●

Reseating the battery into the battery bay can resolve no-battery found and no-charging issues.

●

Reseating memory modules can resolve memory error, no-boot, and blue screen issues.

●

Reseating the storage device can resolve a POST error 3F0 (no boot device) issue (see POST Error
Messages and User Actions on page 126).

●

Reseating the keyboard cable can resolve an unrecognized keys error.

●

Reseating the wireless module and antenna cable can resolve a wireless connection issue.

For field replaceable units (FRUs), authorized service providers can try the following steps (for more
information, see the ”Removal and replacement procedures for authorized service provider parts” chapter).
●

Reseating the fan cable can fix POST error 90B (no fan detected) issue (see POST Error Messages and
User Actions on page 126).

●

Reseating the power cable can fix a no boot issue.

●

Reseating the daughterboards (some models may have a power button board, VGA board, etc.) can
resolve their functional issues.

●

Reseating graphics cables and panel connectors can fix distorted/flickering video.

●

Replacing thermal pads may resolve thermal power-down issue.

11. Test with minimum configuration
The factory-shipped computer (hardware configuration and preinstalled operating system image) is well
tested and ready for use. Therefore, using the original factory hardware configuration and/or booting to
operating system safe mode often resolves issues quickly.
●

Disconnect any external USB storage, remove any discs in optical drives, remove the computer from a
docking station, remove external video, etc.

●

In addition to removing recently added components, the issue can be narrowed down further with a
minimum configuration. For example, if HP PC Diagnostics reports a memory error, test one memory
module at a time to isolate the defective module.

●

If the computer does not successfully boot the operating system, booting to safe mode may help
identify what may be causing the issue as described below.

Essential hardware configuration
NOTE: This step is to be used by authorized service providers only. HP will not honor the warranty for a
system tested with the system board removed without the heat sink, fan, etc.
If none of the steps above resolve the issue, start the computer with essential hardware only. The purpose is
to remove as much as hardware as possible while still maintaining the computer’s ability to turn on.
This essential configuration is often used to troubleshoot power-on related issues, such as no-boot, reboot,
and freezing issues.
The essential hardware consists of the following:

78

●

System board

●

AC adapter (unplug nonremovable battery or remove battery)
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●

Processor (and heat sink/fan). (Processor may be integrated into the system board.)

●

Memory (one verified working memory DIMM)

●

Graphics card (if no VGA port is available on the system board). Platform may have both Intel integrated
graphics and discrete graphics. Therefore, discrete graphics card may not be needed.

●

External VGA monitor

●

External USB keyboard

●

External mouse

NOTE: After the service door is removed, disconnect all connections (internal keyboard, display, discrete
GPU, hard drive/solid-state drive, daughterboards, etc.) to achieve the essential hardware configuration
above. DO NOT disassemble the system board from its enclosure at this time.
Reverse the procedure above by reinstalling each piece of hardware removed, one piece at a time, and testing
your computer after each installation. Since your computer works with only the essential hardware installed,
those parts must be working properly. This means that one of the hardware components removed is causing
the computer to not work properly. By installing each device back into the computer and testing each time,
the failing hardware will eventually be identified.
Safe mode
A driver conflict often results in a blue screen error message. Therefore, booting in safe mode can resolve
many issues in Windows because safe mode forces the computer to load a limited version of Windows which
only contains essential files. Safe mode is useful for troubleshooting problems with programs and drivers
that might not start correctly or that might prevent Windows from starting correctly.
If a problem does not reappear when you start in safe mode, eliminate the default settings and basic device
drivers as possible causes. Refer to the links below for how to start your computer in safe mode:
●

HP PCs – Windows 7 Safe Mode

●

HP PCs – Windows Safe Mode (Windows 10, 8)

12. Test with verified working configuration (hardware and/or operating system)
One troubleshooting technique that can quickly isolate an issue is using a verified working part while testing.
A good example is to use an external keyboard, mouse, or VGA monitor when you have issues with an internal
keyboard, TouchPad, or display. Testing with a verified working AC adapter can identify an error caused by a
faulty one. Similarly, testing with a verified working operating system can determine bad behaviors of the
current operating system. See Non HP diagnostics tools on page 71 for instructions about obtaining and using
a Windows-To-Go USB.
NOTE:

In some situations, more than one item may contribute to a problem.

13. Replace the system board
The system board may be replaced only by authorized service providers. This should not be considered an
initial step taken to resolve an issue. Review and perform all steps discussed previously before replacing the
system board. 4. Update BIOS and drivers on page 67, 7. Status lights, blinking light codes, troubleshooting
lights, and POST error messages on page 72, 8. Hard reset on page 76, and 9. Soft reset (Default Settings)
on page 77, and/or 10. Reseat cables and connections on page 77 can resolve many system board issues
without requiring the effort of replacing unnecessary hardware.
Review Table 7-1 Troubleshooting methodology and general troubleshooting steps on page 63 for
appropriate troubleshooting steps.

General troubleshooting steps
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IMPORTANT: System board failure is not common. Do not replace the system board until you have tried all
other troubleshooting options.
NOTE: Determine whether a previous service case might be related to the current problem. For example, a
fan detection issue may be caused by a loose connection resulting from previous service.
TIP: Without an RTC battery (3V coin-cell battery), the computer automatically reboots. This is a useful
feature when the power connector cable (between external AC adapter and system board) is defective.
NOTE:

Most of the time, effective troubleshooting can prevent a system board replacement.

Items that may prevent resolution of the issue:
●

The information provided about the issue omits key details, including any actions taken before the issue
occurred.

●

BIOS, software, and drivers have not been updated.

●

Cables or connections are loose.

●

Technician is unaware of information available from the HP Support website (i.e., CA - Customer
Advisory).

●

The issue is related to existing or known issues that may be identified in existing support articles.

●

Technician may have omitted steps in the provided repair instructions (e.g., Spare Part Replacement
Instructions).

●

Skipping one of steps from Troubleshooting Methodology table results in No Defect Found (NDF)/No
Fault Found (NFF)/No Issue Detected (NID) messages.

Verify solution
●

Verify that the implemented solution works. Reboot the system or device and try to complete the task
that produced the issue.

●

If a part has been replaced, verify other basic functions. For example, GPU replacement requires
keyboard removal. Therefore, it is good practice to verify all basic components to be sure that the
solution is complete.

●

Explain to the customer why the issue occurred and what was done to resolve it. If the solution you used
was in an HP Public document, provide the document information to the customer, letting them know it
can be located on www.hp.com. Also, tell them that there are other solutions available on the website.
Advise the customer to check the website first when they have an issue. It may save them time calling in.

●

Document the correct issue. Update the case with as many details as possible for other agents and
engineering to analyze and study for lessons learned.

Helpful Hints
After you become familiar with the general troubleshooting steps above (General troubleshooting steps
on page 63), follow the helpful hints below before running diagnostics and troubleshooting.

At startup
TIP: If you have installed an operating system other than the factory-installed operating system, go to
http://www.hp.com/go/quickspecs and verify that it is supported on your system.
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1.

Be sure that the computer is plugged into a working AC outlet.

2.

Be sure that power is connected to the docking station if a dock is used.
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3.

Be sure that the AC adapter light is on.

4.

Be sure that the AC adapter is connected when you update BIOS to avoid BIOS corruption.

5.

Be sure that the computer is turned on, the rear power light is solid white (connected to an external
power source) and the front power light is solid white (normal operation).

6.

Remove all optical and flash drives from your system before turning it on.

7.

Be sure that the boot option is set to a working operating system drive.

8.

Be sure that externally connected monitors are turned on and their power lights are on. Not all monitors
are equipped with lights to indicate their functionality.

9.

Turn up the brightness and contrast controls of a display or external display device if the screen is dim.

During operation
1.

To wake the computer:
a.

Press the power button or any key on the keyboard.

b.

If the system remains in the Sleep (Windows), Suspend (Linux), or Hibernate state, shut down the
system by pressing and holding the power button for at least four seconds.

c.

If the system does not shut down, unplug the power cord, wait a few seconds, and then plug it in
again. Then press the power button again to restart the system. If it does not turn on, press the
power button to start the computer.

2.

Look for blinking lights on the computer. The blinking lights could be error codes that will help diagnose
the problem.

3.

Check all cables for loose or incorrect connections (external devices, power cords, dock, etc.).

4.

After installing a non-Plug and Play expansion board or other option, reconfigure the computer. For
example, if you upgrade to a solid-state drive, you may need to reconfigure the boot order.

5.

Be sure that all required device drivers have been installed. For example, if you have connected a printer,
you must install a printer driver.

6.

If there is a network connection issue, plug another computer with a different cable into the network
connection. There might be a problem with the network plug or cable.

7.

If hardware has recently been installed, remove it and determine whether the computer functions
properly.

8.

If software has recently been installed, uninstall it and determine whether the computer functions
properly.

9.

If the screen is blank, confirm the display choice by pressing Windows logo

+ P and set to screen

only. Or plug an external monitor into a different video port on the computer if one is available and close
the computer lid.
10. Verify that the latest version of BIOS, drivers, and software are installed. A new release might support
new features or fix the problem.
11. Press the caps lock and/or num lock key. If the caps lock and/or num lock light toggles on or off, the
keyboard is likely operating correctly.
12. Press the TouchPad On/Off button light. If the light toggles on or off, the TouchPad is likely operating
correctly.

Helpful Hints
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Consulting with HP Service
If further HP support is required, a lot of the following information may be requested when you call, so it may
be helpful to take notes.
●

Technical support registration number (if applicable)

●

Product serial number

●

Product model name and number

●

Product identification number

●

Applicable error messages

●

Add-on boards or hardware

●

Third-party hardware or software

●

Operating system type and revision level

Common issues and possible solutions
This section contains common issues, symptoms, and a series of tables that describe possible solutions to
issues from Failure classification on page 64 tables. The following sections identify the issue with symptoms
and solutions to resolve an issue.

Power-on issues
No Power
When a unit experiences no power there are several contributing factors to consider. Be sure to consider all
symptoms related to this behavior in troubleshooting.

Symptoms

Possible causes

●

Computer does not start

Failed power input to the computer (external power source, AC adapter, faulty battery).

●

Display is black or blank

Bad connection to the computer (bad power button, power connector).

●

No fan noise

Defective parts (memory, storage device, graphics) or failed system board.

●

No hard drive spinning

●

Lights do not glow
Troubleshooting steps
Perform quick check
Remove all external devices, including docking station.
Verify external power source (2. Examine the environment on page 66).
Perform a hard reset (8. Hard reset on page 76).
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Verify AC adapter
It is preferable to verify the battery before verifying the AC adapter. However, you can
verify the AC adapter first, before opening the service door for a battery check.

NOTE: Refer to battery replacement section
for removing/replacing the battery

●

Verify AC adapter is compatible with product. Verify that the part number is for
this computer if possible.

●

Verify AC adapter and power cord are good (no physical damage, bent middle ID
pin).

●

Verify AC adapter works on a verified working computer.

●

Plug in AC adapter and power on computer without battery.

●

Inspect power port on computer side for any damage, dust, or debris.

●

Check power light (7. Status lights, blinking light codes, troubleshooting lights,
and POST error messages on page 72). Rear power light indicates external power
to the computer is good.

Verify battery condition/status
1.

Check battery condition (overall result, cycle life, voltage, etc.) using HP PC
Hardware Diagnostics (UEFI) or HPSA tools.

2.

Verify that battery is installed properly in battery bay without a gap and that
latch locks are tight (for models with removable batteries).

3.

Check battery status light (7. Status lights, blinking light codes, troubleshooting
lights, and POST error messages on page 72). Be sure that battery is not fully
discharged, preventing system from booting.

4.

Determine whether the computer can turn on with battery only.

5.

Remove service door and test with a verified working battery. If the computer
boots, inspect original battery before replacement.

6.

Test battery with a verified working computer to verify that it is OK.

7.

If there is still no boot, remove battery and boot on AC power only.

The sections below are intended for authorized service providers/technicians.
Verify AC adapter – voltage
1.

Measure DC voltage output that should be around 19.5 VDC and acceptable
voltage range is from 18.5 – 20.5 VDC.

2.

If the DC voltage is out of range, replace the AC adapter.

NOTE:
NOTE: 2015 mWS does not have the power
cable between system board and power
connector on chassis

This action requires a digital voltmeter.

Verify power button, power connector
1.

Be sure that power button is not stuck.

2.

Reseat power connector cable (if applicable).

3.

Replace new power connector cable (if the cable exists and is defective)

4.

To isolate faulty power connector cable and power button, technicians can short
power-on pads/pins to power up the computer. Contact HP Engineering for this
information.

Verify blinking lights (7. Status lights, blinking light codes, troubleshooting lights,
and POST error messages on page 72)
At this point, there should be sufficient power from the AC adapter to the system
board. Expect to hear the fan spinning and see blinking lights or error messages (i.e.,
faulty memory, HDD, etc)

Common issues and possible solutions
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Verify Power Good (Troubleshooting) lights
1.

Verify if the system board has power-on issue related. If there is no power-on
issue, move to next steps. For more information, see Power Good
(Troubleshooting) lights on page 75.

2.

Verify all connections and reseat parts (10. Reseat cables and connections
on page 77).

Verify system board

Tips and tricks

1.

Test essential hardware configuration (11. Test with minimum configuration
on page 78, 12. Test with verified working configuration (hardware and/or
operating system) on page 79, 13. Replace the system board on page 79) by
removing nonessential parts.

2.

If there is still no boot, replace system board.

Computer automatically boots without pressing power button when RTC 3V battery
has been removed. Therefore, after the service door and RTC 3V battery are removed,
no need to press power button from top side.
In essential hardware configuration, mWS G1 and G2 may require discrete GPU to boot.
However, mWS G3 can boot with integrated graphics.
See Overview of How to Troubleshoot Problems When a Computer Does Not Start Up
or Boot Properly

Intermittent power-on, shutdown, reboot

Symptoms
●

Does not always turn on

●

Intermittently hangs

●

Intermittently shuts down

●

Spontaneously reboots

Possible causes
Electrical short, fluctuating power source, unstable power rails, loose connections, bent pins,
stray wires, dust, obvious damage, nearly faulty parts (bulging/leaking capacitor).
Potentially will turn into a no power issue soon (No Power on page 82).

Troubleshooting steps
1.

Visually check power ports on both AC adapter and computer sides.

2.

Inspect power sources:
a.

Verify AC adapter working correctly. Use a confirmed working adapter to test.

b.

Verify that battery is not depleted while system is in Sleep state. Test with a
confirmed working battery.

The sections below are intended for authorized service providers/technicians.
1.
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Follow actions in No Power on page 82.
a.

Be sure that AC adapter has correct DC voltage.

b.

Verify battery - test with a confirmed working battery.

c.

Verify that power button is not stuck.

d.

Verify that power connector is not loose.

e.

Verify that Power Good LEDs are solid.

f.

Remedy loose connections and reseat major components (processor, memory, GPU,
hard drive/solid-state drive, etc).

2.

Perform visual check for loose connections, bent pins, stray wires, dust, nearly faulty parts
(bulging/leaking capacitor).

3.

Test essential hardware configuration (11. Test with minimum configuration on page 78)
a.

If system boots, reinstall nonessential hardware one component at a time to isolate
issue.

b.

If system does not boot, replace essential hardware with verified working parts, one
component at a time. If system still does not boot, replace system board.

AC adapter issue
Solution
Symptoms

Possible causes

●

No sign of power

AC adapter and others (i.e., external power source)

●

No boot

Troubleshooting steps

●

No rear power light

Quick check

●

No front power light

1.

Verify external power source (2. Examine the environment on page 66).

●

Battery does not charge when AC
adapter is connected

2.

Remove all external devices, including docking station.

3.

Perform a hard reset for the computer (8. Hard reset on page 76).

4.

Disconnect and reassemble the power cord and adapter in case the adapter
experienced short circuit, over current, over temperature events.

5.

Use a verified working adapter. If the computer operates normally, there is a
problem with the original adapter.

6.

Verify that the AC adapter works on a verified working computer. If the computer
operates normally, there is no problem with the adapter. See HP Smart Adapter
warning message on page 99 for further information.

Verify AC adapter

Tips and tricks

1.

Remove working battery.

2.

Verify that AC adapter is compatible with product. Verify that part number is for
this computer if possible.

3.

Inspect AC adapter and power cord for physical damage, bent middle ID pin.

4.

Plug in AC adapter and power the computer without battery.

5.

Inspect the power port on computer side for any damage, dust, debris.

6.

Check power light (7. Status lights, blinking light codes, troubleshooting lights,
and POST error messages on page 72). Rear power light indicates that external
power to the computer is good.

7.

If there is still no rear power light or no boot, replace the AC adapter.

The HP Smart AC adapter has a special pin in the middle, called the ID pin, for power
rating and throttling purpose. If this pin is broken, the rear power light will be on but
the power button and front power lights will blink continuously and the computer will
not turn on. Third party AC adapter will not work on the computer.
Use the AC adapter that came with the computer for better performance.
See HP Notebook PCs - Testing and Using the AC Power Adapter

Common issues and possible solutions
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Battery not recognized, not charging

Symptoms

Possible causes

●

No battery status light

Defective AC adapter and/or battery.

●

Blinking amber (critically low
battery level)

NOTE: Before proceeding, verify that the computer can boot to BIOS or Windows with a
good AC adapter.

●

No boot without AC adapter
Troubleshooting steps
Visual inspections
1.

Inspect battery connectors for any signs of damage.

2.

Verify that battery is installed properly in battery bay without gap or obstructions and
latch locks are tight. Reseat battery (for models with removable batteries).

3.

Determine whether battery gets hot (batteries heat up when charging, but not too hot
to touch).

Check battery warranty to see whether the battery is new or its warranty is expired. Battery
capacity degrades over time.
Verify front battery status light
1.

Battery status light is off: battery not recognized.

2.

Battery status light is blinking amber: critically low battery level.

Reset
1.

Hard reset (8. Hard reset on page 76)

2.

Soft reset (9. Soft reset (Default Settings) on page 77)

Verify AC adapter
1.

Determine whether the computer needs the AC adapter to boot and operate.
Sometimes, intermittently bad AC adapter and loose connection between adapter and
computer results in inability to charge battery which causes short run time.

2.

Inspect AC adapter to verify that it is functioning.

3.

Test with a working AC adapter and confirm whether battery is charging.

4.

Be sure that battery is fully charged (AC adapter plugged in at least 2.5 hours).

Diagnostics: HP tools will report results such as passed, calibrate, weak, replace, no battery
and unknown, and suggest corresponding actions.
Use HP Hardware Diagnostics (UEFI) (6. HP Hardware Diagnostics and Tools on page 68)
●

HP PC Hardware Diagnostics (UEFI) is a good tool to use to isolate and determine faulty
battery, especially for quickly discharging (short life) battery.

Use HP Support Assistant tools in Windows (HP Support Assistant (HPSA) on page 70)
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1.

Verify that battery is recognized and charging.

2.

Verify battery condition if battery cycle life is over specs (i.e., long life of 1000-cycle life
and 3-year warranty). Battery may have premature capacity loss within its cycle life or
warranty.

3.

If issue remains, test with a verified working battery and verify battery status lights
and battery conditions.

4.

If issue remains, replace system board.

5.
Tips and tricks

Verify the new replacement.

See the computer user guide for instructions regarding battery maintenance and increasing
battery life.
●

Reference: HP Notebook Mobile Workstations - Improving Battery Performance
(Windows 10, 8, 7, Vista)

●

Reference video: Testing and Calibrating the Battery on PC Notebooks

Battery discharges too fast

Symptoms

Possible causes

Battery has good status light but discharges
too fast

AC adapter and/or battery.
Troubleshooting steps
Verify AC adapter
Determine whether the computer needs the AC adapter to boot and operate.
Sometimes, intermittently bad AC adapter and loose connection between adapter and
computer results in inability to charge battery and causes short run time.
1.

Inspect AC adapter to verify that it is working.

2.

Test with AC adapter alone and with a verified working AC adapter.

Verify battery: Battery capacity can degrade over time, so check the warranty
coverage. Run a battery test to confirm if issue is hardware-related.
1.

Review battery power plans in Control Panel > Power Options that may consume
more energy and discharge battery faster. Resetting default to Power Saver
option can conserve battery power.

2.

Determine whether any graphics processing is running.

3.

Verify battery maintenance and operations. Leaving the battery at a high level of
charge in a high-temperature environment for extended periods accelerates the
loss of capacity.

4.

Test and calibrate battery using HP PC Hardware Diagnostics (UEFI).

5.

Verify battery life cycle using HP Support Assistant tool.
If battery cycle life is over specs (long life battery of 1000-cycle life and 3-year
warranty), battery may have capacity loss beyond its lifecycle or warranty.

6.

Tips and tricks

Compare discharge time with a verified working battery (remove AC adapter)
using Hardware Diagnostics (UEFI) > Hard Drive Tests > Extensive Test > Loop
until error.

To conserve battery power, turn off Wireless On-Off button and other peripherals/USB
devices, applications, processes (in Task Manager) when not in use; also, reduce screen
brightness.
Follow HP instructions of how to maintain battery and increase battery life.
Reference: HP Notebook Mobile Workstations - Improving Battery Performance
(Windows 10, 8, 7, Vista)
Reference video: Testing and Calibrating the Battery on PC Notebooks

Common issues and possible solutions
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Burnt smell

Symptoms

Possible causes

Emits smoke, burnt smell

Defective on-board components.
Troubleshooting steps
General visual inspection
1.

Disconnect the computer from power source (AC adapter and battery).

2.

Inspect for visual damage on AC adapter and battery. Test on a known working
computer to isolate issue. If issue follows AC adapter or battery, replace it.

3.

Inspect any sign of liquid spill on the computer (back of keyboard).

The sections below are intended for authorized service providers/technicians.
Further inspection on components
1.

Inspect further sources internally after disassembling chassis, such as burnt or
damaged components.

2.

If the issue persists, replace boards, AC adapter, and battery for safety concern
and report issues to HP.

POST
No video (with power)

Symptoms
●

No video (black/blank image) but
have power

●

Light activity

●

No error messages

●

Fan noise

●

Hard drive light blinking and hard
drive noise

Possible causes
Failed display
Failed critical components (memory, storage device, system board)
Loose connection
Recently added hardware
NOTE:

Assume the computer has not previously been set up for multiple displays.

Troubleshooting steps
Quick check
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1.

Verify that system light activity is OK.

2.

Remove all external devices, including docking station. Recently added hardware
and/or applications may cause graphics driver conflict and result in loss of video.

3.

Perform hardware reset (8. Hard reset on page 76) and verify that HP Logo is presented
correctly on display screen when pressing F10.

4.

Test with external monitor via VGA port (or DisplayPort, HDMI, etc). Press power button
and close the computer lid to force video output to external video. If unsuccessful,
contact HP service.

5.

If external video is OK, update BIOS, software, and drivers (4. Update BIOS and drivers
on page 67) and perform soft reset (9. Soft reset (Default Settings) on page 77) if
needed. Go to next step to verify display.

Verify display
●

When booting to Windows, determine whether image appears on display screen (via
Windows Screen Solutions or Windows logo

●

+ P for display switcher).

If there is video on display, disconnect external display device, open the computer lid
and restart.

The sections below are intended for authorized service providers/technicians.
1.

Verify Power Good lights are on to be sure that system board power is functional.

2.

Reseat display cable connection on system board.

3.

Reseat display cable connection on display panel side.

4.

Examine and reseat major components, such as storage device, memory.

5.

Test with minimum configuration (11. Test with minimum configuration on page 78) by
removing storage device to isolate operating system issues and testing video in F10
Setup.

6.

If video is present, restart and retest the computer.

7.

If video is present but bad, go to Display on page 100 section.

8.

If issue persists (no video), test with external video.

9.

If issue persists, test or replace a confirmed working display.

10. If issue persists, replace discrete graphics card.
11. If issue persists, replace system board due to defective video function.
Tips and tricks

Swipe a metal piece (screwdriver) over wireless/mute buttons to act as if closing lid to force
video output to external display device. See the “External component identification –
Display” section for location of the magnetic sensor.

Blinking lights

Symptoms

Possible causes

Lights blink on keyboard caps
lock/num lock keys

Blinking lights on startup usually indicate a problem with basic functionality of a critical
component (processor, BIOS, graphics cards, memory, etc.) due to loose connection,
defective parts, or recently added parts.
Troubleshooting steps

Note

1.

Check for any blink patterns. Count the number of blinks in a sequence, followed by a
pause for a few seconds.

2.

See Status, Blinking Lights, and Error Message (7. Status lights, blinking light codes,
troubleshooting lights, and POST error messages on page 72) for corrective actions.

3.

If internal hardware components (memory, storage device, etc.) have been recently
added, a component may not be connected properly. Remove and reseat new
components (10. Reseat cables and connections on page 77) one at a time.

Since the display may not be functional, lights are used to indicate an error.

Common issues and possible solutions
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Diagnostics error messages

Symptoms
●

Computer has power

●

POST error message displays
(Windows logo has not yet
appeared)

Possible causes
Diagnostic error messages indicate a problem. There may be a problem with the instruction
being sent from the BIOS to a hardware component (e.g., keyboard failures), or
incompatible hardware. Can usually be resolved by installing updated firmware for the
component.
Troubleshooting steps

Note
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1.

See 7. Status lights, blinking light codes, troubleshooting lights, and POST error
messages on page 72 for corrective actions. An example of a POST error message is
shown below.

2.

If there is power, you may be able to access BIOS. Reset BIOS to its default condition.
(9. Soft reset (Default Settings) on page 77)

3.

Restore hardware to its original condition (i.e., bootable solid-state drive instead of
hard drive).

4.

Reseat suspected components and verify connection.

5.

Test suspected components using HP PC Hardware Diagnostics (UEFI) tool.

An Error Message means the system has finished BIOS hardware validation and is ready to
launch the Startup Menu. To access the Startup Menu for further options, press the Esc key
while restarting the computer.

BIOS password

Symptoms

Possible causes

Some sections are unavailable (grayed
out)

BIOS administration password is required.
Troubleshooting steps

Reference

1.

Review F10 BIOS Setup Overview to determine which features must be enabled.

2.

Your BIOS settings may be managed by a BIOS administrator password setup.

3.

If you lost or forgot user password, contact your IT personnel.

4.

If you lost or forgot administrator password, contact HP service to reset the password.
This process requires a unique UUID.

HP F10 Setup Overview
HP Business Notebook and Desktop PC F10 setup overview – 2012 and 2013 Business PC
models
HP Business Notebook and Desktop PC F10 setup overview – 2014 Business PC models
2015 Business PC models – see the BIOS F10 Setup technical white paper at
http://support.hp.com, enter your computer model, and then go to Manuals > White papers
> HP PC BIOS F10 Setup Guide.

Performance (OS)
NOTE:

Most software problems occur as a result of the following:

●

The application was not installed or configured correctly.

●

There is insufficient memory available to run the application.

●

There is a conflict between applications.

Make sure that all the needed device drivers are installed.
If an operating system other than the factory operating system is installed, check whether the operating
system is supported and the application is certified for the version of the operating system.
HP ships and supports Windows 7 with BIOS Legacy boot mode and Windows 8, 10 with BIOS UEFI boot mode.
Therefore, HP recommends that you switch BIOS boot mode from Legacy to UEFI Native for clean Windows 8,
10 installations, or to UEFI Hybrid (if available) for upgrading the option from Windows 7 to Windows 8, 10.
UEFI Windows 8, 10 avoids many unexpected behaviors (i.e., blue screen error, graphics/video issues) in the
BIOS Legacy setting.

Common issues and possible solutions
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Intermittent shutdown

Symptoms
●

Shutdown during startup

●

Shutdown during operation

Possible causes
It is often difficult to troubleshoot an intermittent issue. Possible causes include the
following:
Power-related issue: defective or insufficient power sources, poor connection.
OS Custom Setting: Energy Saver (Power Management).
Thermal-related issue: thermal sensors reach limits.
Hardware related issue: voltage, out-of-range current; electrical short.
Troubleshooting steps
1.

Update BIOS and drivers. (4. Update BIOS and drivers on page 67)

2.

Perform hard reset (8. Hard reset on page 76)

3.

Perform soft reset (9. Soft reset (Default Settings) on page 77)

Power related issue
1.

Verify functionality of AC adapter alone. If no functionality, test with a verified working
adapter.

2.

Verify battery alone. Verify that battery is not depleted. Test battery using HP PC
Hardware Diagnostics (UEFI) tool.

3.

Verify connection of power button, power cable.

OS custom settings
1.

Advise users to reset power options and close all applications that are not in use,
including applications in the background.

2.

Test with a confirmed working operating system to isolate custom settings by users or
any conflicting applications that cause shutdown.

The sections below are intended for authorized service providers/technicians.
Thermal-related issue
1.

2.

Verify thermal condition:
a.

Test fan using HP PC Hardware Diagnostics (UEFI) tool (6. HP Hardware
Diagnostics and Tools on page 68)

b.

Check fan and connection. Reseat fan cable.

c.

Be sure that no obstructions or dust are in heat sink fan, fin, or vent.

d.

Test with a verified working fan.

e.

Remove old thermal compound and pads and replace with new compound and
pads.

Verify thermal solution:
○

Use Thermal Monitor tool (available only to authorized service providers/
technicians) to perform stress test (processor and GPU) (6. HP Hardware
Diagnostics and Tools on page 68) and verify that thermal sensors are within
limits after thermal condition is serviced.

Hardware related issue
1.
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Check for any signs of loose connections, bent pins, stray wires, dust, nearly faulty
parts (bulging/leaking capacitor).

Tips and tricks

2.

Verify that lights are solid.

3.

If shutdown is reproducible, test essential hardware configuration:
a.

If no issue with hardware configuration, reinstall one non essential component at
a time to determine faulty hardware.

b.

If issue persists, replace essential hardware with a confirmed working part, one at
a time. If no boot, replace system board.

Intermittent issue is difficult to reproduce and troubleshoot. It is important to record details
on shutdown frequencies, system configuration (3D video application) and operating
conditions.

Blue screen

Symptoms
●

Have power, light activity, fan spinning

●

HP Logo displays briefly

●

Fails to boot into Windows operating
system, displays blue screen, and then
crashes, restarts, or stops responding

Possible causes
Recent changes: conflict of instructions from multiple programs or just added
hardware.
Incompatible hardware and driver.
Poor connection (storage device, memory).
Hardware malfunctioning due to overheating (GPU, processor).
Defective hardware (memory, storage device).

Important Notes & Resources

Troubleshooting steps
There are many different ways to troubleshoot a blue screen error. Therefore, you
need to identify working configuration (Windows 7/8/10) and specific symptoms
of the failure in order to narrow down the issue. Refer to Blue screen (BSOD) error
on page 117.
Recommended resources
Microsoft knowledge base:
Resolving Blue Screen errors in Windows
HP Troubleshooting Error Messages on a blue screen:
HP Notebook PCs - Troubleshooting Error Messages on a Blue Screen that may
Occur During Startup or Boot

Overview of General Troubleshooting Steps for a blue screen error
1.

Note the blue screen error message and what activity was performed at the time.

2.

Perform a hard reset (8. Hard reset on page 76) after disconnecting all external peripherals.

3.

Reset BIOS to default (9. Soft reset (Default Settings) on page 77) to prevent booting to another device.

4.

Run HP Hardware Diagnostics (6. HP Hardware Diagnostics and Tools on page 68) to isolate major faulty
hardware issues.

Common issues and possible solutions
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●

HP PC Hardware Diagnostics (UEFI) tool to test storage device, memory and system.

●

Thermal Monitor (available only to authorized service providers/technicians) tool to monitor
temperature limits of processor and GPU. See “HP Thermal Monitor” in 6. HP Hardware Diagnostics
and Tools on page 68.

5.

Remove or undo recently added hardware (5. Remove or uninstall recently added hardware, software
on page 67). For example, incompatible memory or new solid-state drive storage.

6.

Reseat cables and connections (10. Reseat cables and connections on page 77). Pay attention to proper
installation of memory and storage device.

7.

Verify that a minimum of at least 100 MB of free space is available on your Windows partition.

8.

If you can start Windows:

9.

a.

Update BIOS and drivers (4. Update BIOS and drivers on page 67) to support updates for
incompatibilities.

b.

Get all the latest updates, using Windows Update.

c.

Undo recent changes:
–

Startup using Last Known Good Configuration.

–

Use System Restore.

–

Roll back device driver in Device Manager.

d.

Check for specific Error Message. See Common Blue Screen Error Messages on page 128.

e.

Boot to safe mode (11. Test with minimum configuration on page 78) to troubleshoot issues.

If you cannot start Windows:
a.

Boot to safe mode. (11. Test with minimum configuration on page 78)

b.

Use Startup Repair to fix Windows startup files.

c.

Undo recent changes using System Restore to revert to a previous “working” state.

d.

Check for specific STOP error by analyzing Crash Dump (retrieved via a bootable USB). See Use
Windows Debugging Tool on page 129.

e.

Restore computer using System Recovery or image backup to factory settings.

10. Lastly, test with essential hardware configuration (11. Test with minimum configuration on page 78)
along with a verified working operating system (i.e., USB Windows-To-Go), if available, to isolate the
software issue.
Tips & tricks
In some cases, the computer may reboot automatically before you have time to read the blue screen.
To identify the error message itself, disable the automatic restart using one of the following methods:
Right-click on My Computer, and then select Properties > Advanced. Under Startup and Recovery, select
Settings. Clear the Automatically Restart check box.

94

Chapter 7 Troubleshooting guide

Windows Advanced Boot Option
Windows 7:
1.

Press F8 to open the Windows Advanced Boot Option screen.

2.

Select Disable automatic restart on system failure to view error messages.

Windows 8:
1.

Press F11 (System Recovery) to open the Windows Advanced Boot Option screen.

2.

Select Startup Settings to view error messages.

Freeze at Windows Logo (hang/lockup)

Symptoms
●

Has power, light activity, fan spinning

●

HP Logo displays briefly

●

Attempt to boot to operating system and
freeze/hang at Windows logo

●

No response to pressing num lock or caps
lock key

Possible causes
Conflict of instructions from multiple programs or drivers; installing a new hardware
or program that is not compatible (may also cause a blue screen error—see blue
screen issue).

Common issues and possible solutions
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Troubleshooting steps
Follow suggested steps below one at a time to verify normal boot process:

Tips and tricks

1.

Disconnect all external peripherals, and perform a hard reset (8. Hard reset
on page 76).

2.

Perform soft reset (9. Soft reset (Default Settings) on page 77).

3.

Update BIOS and drivers (4. Update BIOS and drivers on page 67).
a.

Roll back to previous version may be necessary.

b.

Go to safe mode to install drivers.

4.

Run Hardware Diagnostics (6. HP Hardware Diagnostics and Tools on page 68)
to isolate hardware issue.

5.

Undo recent changes in Windows (5. Remove or uninstall recently added
hardware, software on page 67).

6.

Reseat cables and connections (10. Reseat cables and connections
on page 77).

7.

Start Windows in safe mode (11. Test with minimum configuration
on page 78).

8.

Use Startup Repair Windows to fix Windows damaged files.

9.

Test with essential hardware configuration (11. Test with minimum
configuration on page 78) along with a verified working operating system (i.e.,
USB Windows-To-Go ) if available to isolate the software issue.

For more information, see HP PCs - Using Task Manager (Windows 10, 8).

Electromagnetic Interference (EMI)
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Symptoms

Possible causes

System locks up, freezes in certain
physical area or location

Electromagnetic interference (EMI).
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Troubleshooting steps
1.

See (2. Examine the environment on page 66). Pay attention to external power source,
high-frequency signals such as cell phones, microwave ovens.

2.

Move the computer to different locations nearby to determine where it fails and where it
does not fail.

3.

Test with a verified working computer in original factory configuration.

4.

Consult with support.

No wake up

Symptoms

Possible causes

When resuming from a power
management state the computer may
display:

Power-saving mode; multiple-display setting.

●

Blank screen

●

Some light activity

Troubleshooting steps
1.

Verify that front power light (7. Status lights, blinking light codes, troubleshooting
lights, and POST error messages on page 72) is blinking (indicating Sleep state). Press
power button to exit Sleep.

2.

Reset BIOS to default (associated with OS Power Management in Power Menu) (4.
Update BIOS and drivers on page 67)

3.

Verify power management settings in Windows Power Options. Disable Sleep options if
the issue is resolved.

4.

Screen saver is set. Press any key or touch TouchPad to resume.

5.

Verify that Display Choice is set to external video only. Toggle screen control key
combination Fn + F4 or Windows logo

Tips and tricks

+P.

If you are using a docking station, set your notebook display as a primary display. When the
computer is undocked, you may think it is in a power-saving state, but the screen image may
actually display on an external display device in the docking configuration.

Common issues and possible solutions
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Unresponsive

Symptom

Possible causes

Unresponsive

Program in use has stopped responding to commands.
Troubleshooting steps
1.

If possible, use the Windows Task Manager to isolate and terminate the offending
process.

2.

Attempt the normal Windows shutdown procedure.

3.

Restart the computer using the power button.

Slow performance

Symptom

Possible causes

Slow performance when performing
small tasks, or even in idle mode

Processor is hot or storage device is full.
Troubleshooting steps
Processor is hot
1.

Verify that airflow to the computer is not blocked.

2.

Verify that chassis fans are connected and working properly. Some fans operate only
when needed.

3.

Verify that the processor heat sink is installed properly.

Storage device is full
1.

Transfer data from the storage device to create more space on the storage device.
Microsoft recommends at least 200 MB to sync system files.

2.

Perform disk defragmentation to consolidate fragmented data on the hard drive so it
will work more efficiently.

Also see Slow performance on page 117.
Tips and tricks

See Improving System Performance (see Routine Maintenance for Performance
Improvement on page 128).
See Tips to free up drive space on your PC.
See Optimize Windows for better performance.
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HP Smart Adapter warning message

Symptom

Possible causes

Warning message displayed in Window

Less powerful AC adapter, BIOS out of date.

Troubleshooting steps

Note

1.

Update BIOS that may contain a table that assigns an appropriate adapter for
a certain configuration.

2.

Update the latest HP Hotkey Support software from Drivers website.

3.

Verify sufficient power source (where adapter is connected).

4.

Use appropriate AC adapter (often supplied with system) for optimum
system performance.

5.

Test with a verified working AC adapter.

6.

Test the adapter on a verified working computer.

7.

Contact HP for configuration details.

HP Smart AC adapter warning message: informs you that as power demands
increase, the notebook may not perform at full capacity, which may result in
longer battery-charging time. In cases of extreme power demands, the system
may also throttle back the processor, or with systems that have a discrete video
sub-system, a video balance mode may occur to further balance the power needs
of the system.
System processor functions always have priority over battery charging, so
charging delays will occur first.

Incorrect time and date

Symptom

Possible cause

Incorrect date and time

Real-time clock (RTC) battery might need replacement.
Troubleshooting steps
1.

Reset the date and time in the operating system Control Panel.

2.

Replace the RTC battery.

3.

Verify that date and time are correct.

Common issues and possible solutions
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Display
Display anomalies
The display panel is a field replaceable unit (FRU) and must be replaced by only authorized technicians.
However, HP highly recommends that users and technicians observe specific symptom vs. generic symptoms
and utilize the HP PC Hardware Diagnostics (UEFI) tool before any replacement.
Symptom
Common display issues with symptoms:
●

Blank/black video

●

Incorrect/missing color/distorted image

●

Flickering image

●

Vertical lines (due to LDVS, decreased signal integrity, and data loss)

●

Dead pixel (due to display liquid, internal transistor, etc.)

●

Horizontal lines (due to video memory)

●

Distorted when hot (due to thermal issue)

●

Cracked screen/image (physical damage)

●

Light leakage/bleeding
Contact support for assistance.

●

Humming noise (due to frequency settings)
Contact support for assistance.

Cracked screen

Cracked image

Blurred image

Dead pixel

Vertical lines

Horizontal lines
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Quick check
●

Visually examine the display for cracked screen, liquid crystal leak, dirty spots on glass, etc.

●

Reset and update BIOS and docking firmware.

●

Update operating system (OS), graphics/video drivers (Intel/AMD/NVidia, etc).
For custom images, HP highly recommends upgrading or installing Windows in UEFI mode (or Legacy
disabled) to fully support hybrid graphics and avoid unexpected behaviors (i.e., blue screen error,
graphics/video issues) in the BIOS Legacy setting.

●

Configure Windows settings (Power options, Screen brightness, Personalization, Screen resolution, etc.).

●

Test with a verified working external display.

●

Boot to Windows in safe mode.

●

Test with a verified working operating system (i.e., shipping image).

HP PC Hardware Diagnostics (UEFI) for video test
Use this tool to quickly determine if the display issue is related to a real hardware issue.
To start HP PC Hardware Diagnostics (UEFI) (6. HP Hardware Diagnostics and Tools on page 68), when the
computer is at boot, press the F2 key, select Component Tests, and then select Video.
There are three options:
●

Video Memory Check: to test video memory

●

Palette Check: to test the three video color components (red, green, blue)

●

Dead Pixel Check: to check dead pixels in eight different colors (Dead Pixel Check is available with the
“HP PC Diagnostics 3-in-1 USB Key” tool)

Review the video troubleshooting in the Display section below for specific issues and possible solutions. For
additional information about display problems, refer to documentation provided by the product
manufacturer.
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Display assembly diagram
The display assembly diagram shows basic video components: system board, graphics cards, display cables,
display connectors, operating system (OS), graphics driver, and LCD display panel. Any component or a
combination of these components can contribute to a video issue.

NOTE: The lid close switch is a Hall-effect sensor located in the top cover. When the display is closed, the
sensor acts like a switch is closed. A notebook can force a video output to an external monitor, or go to
hibernation or standby mode through power management. If the display screen does not light up when the
display is open, the lid close switch (Hall-effect sensor) could be faulty.

Dead pixel
Display panel may show one or more pixels that are not properly lit when displaying a single color over the
screen area. Use HP PC Hardware Diagnostics (UEFI) tool to determine those defective pixels. There is no
solution for dead pixels. Refer to Display Issue: Pixel Anomalies on page 134 for the HP dead pixel policy.

No video (internal)

Symptoms

Possible causes

No internal video with certain
programs (i.e., video-intensive games)

Display resolution, brightness, faulty lid switch, running a program requiring a higher
resolution than the display screen can support..
Faulty lid switch may put the system into Sleep or Hibernation mode.
Troubleshooting steps
Use an external monitor with higher resolution.
Test with external monitor using HDMI or HP port. Press the power button and close the
computer lid to force video output to external video. If there is still no video, contact support.

References
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See section No video (with power) on page 88 for display information.

No video (external)

Symptom

Possible causes

No image on external monitor

External monitor, resolution, display configuration, drivers.
Troubleshooting steps
1.

Be sure external monitor is compatible with the computer.

2.

Be sure that external monitor is turned on.

3.

Press any key to get out power saving mode.

4.

Adjust the brightness of the monitor.

5.

Test with a verified working monitor.

6.

Test the monitor via internal ports (VGA, DP ports).

7.

Install latest video driver.

8.

Reset the screen resolution as described in the documentation.

9.

Configure display choice, and then force output to external video by closing the
notebook lid or pressing Fn + F4 to switch screen output.

DisplayPort/VGA
See No video (external) on page 103.

HDMI

Symptoms
●

Display issue

●

Sound issue

Possible causes
Cable, connection, settings.

Troubleshooting steps
Quick Check

References

1.

Verify HDMI device input source is set correctly (i.e., HDMI1).

2.

Be sure you are using the correct HDMI cable.

3.

Check connection and reconnect the HDMI cable.

4.

Verify if sound output is configured correctly in Control Panel > Sound Manager.

1.

Perform hard reset (4. Update BIOS and drivers on page 67).

2.

Update BIOS and drivers (4. Update BIOS and drivers on page 67) when sound is heard but
no video on HDTV.

HP Notebook PCs - Troubleshooting HDMI Display and Sound Issues
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No or bad external video via docking

Symptoms

Possible causes

No or bad image on external monitor
via ports of docking station (VGA, DP,
TB, display port, etc.)

Rooted from system board, software/drivers, dock connectors, docking station hardware/
firmware, dock video ports (DP, VGA, etc).
Troubleshooting steps
1.

Be sure that external monitor is powered on.

2.

Be sure that external monitor is compatible with the computer.

3.

If applicable, plug the dock in different Type-C ports.
For more information, see the technical white paper titled ”HP ZBook 65/150/200 W
Thunderbolt 3 Dock User Guide.” Go to http://support.hp.com/, enter your model
number, and then click Manuals > Technical white papers.

Note

4.

If the screen image is distorted, try a DP-to-VGA adapter. Connect the adapter to each
DisplayPort and VGA port of the dock.

5.

Test the monitor via internal ports (VGA, DP, HDMI, etc.).

6.

Verify that dock connectors of the notebook and the dock are clean, without dust,
debris (e.g., using air duster).

7.

Ideally, use a verified working operating system/system connected to the dock to
isolate the issue of the current operating system.

8.

Ideally, use a verified working docking station to isolate the faulty dock.

9.

Update latest dock firmware. Be sure to follow the installation instructions carefully.
You may want to try a DP-to-VGA adapter if you have a distorted screen image. Connect
the adapter to each DisplayPort of the dock. If you still cannot update the dock,
attempt to update it on a confirmed working notebook before having the dock
replaced.

See the technical white paper titled “Multiple displays on HP ZBook Mobile Workstations”
from HP platform support website. Go to http://support.hp.com/, enter your model number,
and then click Manuals > Technical white papers.

Incorrect or missing color/distorted image

Symptoms

Possible causes

System works normally but the display
shows:

Loose connection, display cable, display, graphics card.

●

Missing or strange color

●

Image distortion

Troubleshooting steps
Verify with external monitor (i.e., VGA)
1.

Use combination Fn + F4 to enable output to external monitor.

2.

Close the lid.

If the external monitor also shows incorrect color, it is graphics card issue. Test with a
verified working graphics card.
Verify display cable and cable connection–Display disassembly is required.
Be sure that external display cables are not pinched or damaged.
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Be sure that external display cables have good connection at both ends (system board and
display panel).
●

If moving cables affects the image, it is display cable. Test with a confirmed working
cable.

●

If moving cables does not affect the image, is display issue. Test with a confirmed
working display

Touch screen

Symptoms

Possible causes

Unresponsive

Dirt and smudge, driver, touch display configuration, power management.

Inaccurate

Troubleshooting steps
Quick check
Turn off the computer, spray glass cleaner onto a soft, damp cloth, and gently
wipe the screen to remove dirt and smudge.
NOTE:

Configure the touch display in Control Panel >
Tablet PC Settings

Do not spray cleaner directly onto the screen.

1.

Restart the computer.

2.

Verify touch screen and graphics drivers.

3.

Configure the touch display to identify the screen as a touch screen as shown
in the image at left.

4.

Calibrate the screen and reset if touch functionality is still not working
correctly.

5.

Perform diagnostic test in HP Hardware Diagnostics under Component Tests
> Touch Screen.
If the diagnostics tests pass but the touch screen still does not respond,
continue following the steps.

6.

Adjust the power management settings for your touch screen.
If the touch screen stops working after waking from sleep, adjust the power
management settings so that the touch screen device stays active while the
computer is in sleep mode.

References

7.

Perform Microsoft System Restore and restore to a time when the system
was working.

8.

Perform HP System Recovery if none of the above actions resolves the issue.

HP Notebook PCs - Touch Screen Issues (Windows 10)
HP Notebook PCs - Touch Screen Issues (Windows 8)
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I/O devices
NOTE:
●

Make sure external devices are supported and compliant (i.e., USB Type C, Thunderbolt 3, PCI Express,
etc).

●

If you have problems with external devices not provided by HP, contact device manufacturers for
compatibility and latest drivers prior to troubleshooting (i.e., USB devices, Thunderbolt devices, PCI
Express Card reader, VGA/Display/HDMI monitors, Speakers, etc).

●

Be sure I/O devices are properly inserted into the I/O ports, and then be sure the I/O devices are
recognized by Windows Device Manager.

Keyboard

Symptoms

Possible causes

Keystrokes not recognized

Dust trapped under keycap, loose keycap, loose keyboard connection, defective keyboard.

Characters not matched
Troubleshooting steps
1.

Inspect the keyboard for any signs of dust, liquid, or debris trapped under sticky keys
that might prevent keystroke recognition.

2.

Check for incomplete connection between keyboard and system board by verifying that
caps lock or num lock light turns on when key is pressed.

3.

Verify whether the keyboard is recognized in Windows Device Manager and verify
whether the keyboard driver is installed properly.

4.

Test with a working external keyboard (i.e., USB keyboard).
Also test in Windows for special keys (Caps Lock, Shift, Ctrl, Fn, Windows, Alt) if
necessary.

5.

Test with HP PC Hardware Diagnostics (UEFI) to isolate a hardware issue from a
software issue.

6.

Verify that BIOS is up to date. If so, resetting BIOS to default may help.

7.

Test with verified working operating system or restore operating system to be sure that
the issue is not caused by different language settings, sticky keys feature, etc.

8.

Verify that keyboard flex cables are fully inserted and in good condition.

The sections below are intended for authorized service providers/technicians.

Tips and tricks
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1.

Verify if keyboard flex cable is in good condition (no delamination or torn cable end, no
missing or cracked tracks, pads).

2.

Verify keyboard flex cable ends are fully inserted and aligned with connectors on
system board, and those connector tabs are properly closed. Reseat cables.

3.

Replace new internal keyboard and retest.

A key only works when pressed with force. Inspect and remove debris trapped under keycap.

Keyboard point stick

Symptom

Possible causes

Point stick not working properly

Dust trapped under point stick, loose point stick cap.
Troubleshooting steps
1.

Inspect any signs of dust, liquid spill that prevent point stick from working.

2.

Check whether point stick cap is loose and reseat it if necessary.

The sections below are intended for authorized service providers/technicians.
1.

Verify whether keyboard flex cables are in good condition (no delamination or torn
cable end, no missing or cracked tracks, pads).

2.

Verify keyboard flex cable ends are fully inserted and aligned with connectors on
system board and back of keyboard and that connector tabs are properly closed.

3.

Reseat point stick cables.

Example of back of keyboard, including
keyboard, point stick, and backlight
cables.

Keyboard backlight

Symptom

Possible causes

Backlight function not working
properly

Backlight disabled, loose connection.
Troubleshooting steps
NOTE:

Not all notebook computers have backlit keyboards.

A keyboard function key lets you turn the light on and off. Verify if backlit feature is not
disabled by pressing a combination of Fn + Backlit key.
The sections below are intended for authorized service providers/technicians.
1.

Verify if backlight flex cables are in good condition (no delamination or torn cable end,
no missing or cracked tracks, pads).

2.

Verify backlight flex cable ends are fully inserted and aligned with connectors on
system board and that connector tabs are properly closed.

3.

Reseat backlight cable.
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TouchPad

Symptoms

Possible causes

Not working properly

On/Off enabled, driver, settings.

(1) – Touchpad on/off button

Troubleshooting steps

(2) – Touchpad

1.

Ensure touchpad On/Off light is not amber (disabled). Double touch to enable.

2.

Verify if touchpad device is listed in Device Manager > Mice and other pointing
devices.

3.

Install the latest touchpad driver.

4.

Adjust touchpad settings (Control Panel > Mouse).

5.

Test touchpad controller using the HP PC Hardware Diagnostics (UEFI) tool (F2 >
Component Tests > Mouse Test > Pointer Test & Drag and Drop Test).

The sections below are intended for authorized service providers/technicians.
1.

Check the touchpad cable for damage or a loose connection, and then reseat the
touchpad cable.

2.

If issue persists, replace the touchpad and verify the change.

Network Connectivity Ethernet (RJ-45 jack)

Symptoms
●

Unable to find networks (yellow bang)

●

Connection dropouts

●

Slow performance

Possible causes
Network source, cable, connection, RJ-45 port, driver, settings.

Troubleshooting steps
Quick Check: verify the network status lights that supposed to flash when
there is network activity.
HP Support Assistant tool - No network detected in
HPSA
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1.

Turn off the computer’s wireless feature (press wireless button).

2.

Verify that networking source with recommended distance to the base is
less than 300 feet.

3.

Examine the Ethernet cable for damage. Test with a verified working
cable.

4.

Test with different networks and jacks and check with IT for hardware
compatibility settings.

5.

Connect a verified working RJ-45 cable directly to the computer to isolate
other related issues (e.g., router, switch, docking station).

6.

Verify Ethernet port lights (RJ-45):
–

Green (left): network is connected.

–

Amber (right): network is showing activity.

7.

Test with HP Support Assistant in Windows.

8.

Diagnose with HP PC Hardware Diagnostics (UEFI) to isolate a hardware
issue from a software issue.

9.

Examine Ethernet ports on the computer, docking station, and wall for
damage, dust, obstructions.

10. Update drivers: Verify that Ethernet module is displayed in Device
Manager and be sure that device driver is up to date. If updating drivers
does not help, try rolling back to previous drivers.
11. Reset BIOS to Default: If other devices can connect to network, but
computer cannot connect, a BIOS setting might be the cause of the
problem. Restore BIOS to default.
12. Test with verified working operating system or perform operating system
recovery to verify that the issue is not caused by customized settings.
13. Replace system board and verify that the issue is fixed.

Network connectivity wireless (WLAN)

Symptoms
●

Unable to find networks (yellow bang)

●

Connection dropouts

●

Slow performance

HP Support Assistant tool - No network detected in
HPSA

Possible causes
Network source, cable, connection, wireless module, driver, settings.

Troubleshooting steps
1.

Turn off the computer’s wired network (remove RJ-45 cable).

2.

Examine environment for interference, such as cell phone or microwave,
that may emit high frequencies (above 1 GHz).

3.

Verify wireless source by moving computer closer to the wireless base/
router.

4.

Test with different wireless networks and check with your IT department for
hardware compatibility, settings.

5.

Verify that the wireless light is on. If the light is amber, press the wireless
button to enable the wireless device.

6.

Test with HP Support Assistant in Windows.

7.

Diagnose with HP PC Hardware Diagnostics (UEFI) to isolate a hardware
issue from a software issue.

8.

Update drivers: Verify that wireless module is displayed in Device Manager
and be sure that wireless drivers are up to date using www.hp.com or HP
Support Assistant. If updating drivers does not help, try rolling back to
previous drivers.

9.

Reset BIOS to Default: If other devices can connect to your wireless
network, but your computer cannot connect, a BIOS setting might be the
cause of the problem. Restore BIOS to default.

Wireless Adapter Properties - U-APSD support

10. Configure power management advanced settings as necessary.
In the example to the left, U-APSD support (Unscheduled Automatic Power
Save Delivery) is changed to Disabled to resolve an incompatible access
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point. If disabling U-APSD improves the throughput issue, check with the
access point provider for updated firmware that resolves the issue.
11. Test with verified working operating system or perform operating system
recovery to verify that the issue is not caused by customized settings.
12. Test with a verified working wireless module.

The sections below are intended for authorized service providers/technicians.
1.

Verify that the wireless module and its antenna cables are fully inserted
and in good condition (see WLAN module removal and replacement
section). Reseat wireless module and antenna connection.

2.

Verify module antenna cable connection are not loose.

3.

Verify antenna cables are properly connected to the MAIN and AUX
terminals (see WLAN module removal and replacement section).

USB

Symptoms
●

USB devices are not recognized

●

USB devices are not charging

Possible causes
USB devices do not have the latest software drivers, port insufficient power, or not
compliant.
NOTE:

Examples of USB device Not Recognized
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USB Type-C uses a different connector entirely

Troubleshooting steps
1.

Unplug USB device and/or restart the computer (wait for 2-5 minutes) to reset USB
port/hub in case of power surge.

2.

Soft Reset (9. Soft reset (Default Settings) on page 77) and verify if USB device is
recognized.

3.

Verify if USB device is recognized in Device Manager > Universal Serial Bus
Controller, or USB is recognized without Yellow bang.

4.

Verify if the latest USB driver or/and USB chipset driver are installed. USB driver
could be removed and reinstalled.

5.

Make sure USB device is supported, for example, USB 3.0 device requires more
power drawn (0.9A) from USB port than USB 2.0 device (0.5A). As a result, identify
USB charging port to be used for charging a USB device, or an external AC power
adapter may be required for an external USB storage to work properly.

6.

Test with verified working USB devices (keyboard, mouse, USB key) to make sure
USB ports are functional.

7.

Test USB device on a verified working computer to make sure USB device is not
malfunctioning.
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Smart card reader

Symptoms

Possible causes

●

Not recognized

Physical damage, incorrect insertion, dirt, driver, malfunctioning card reader.

●

Unable to write

NOTE: Some cards have a read/write security switch on the card. Make sure that
switch is set to “write enabled” before attempting to write data to it.

Card Reader Removal Policy

Troubleshooting steps
1.

Verify card reader removal policy.

2.

Make sure there is no physical damage to the card.

3.

Inspect the ends of the memory cards for dirt or material closing a hole or
spoiling a metal contact. Clean the contacts with a lint-free cloth and small
amounts of isopropyl alcohol. Replace the memory card if necessary.

4.

Reinstall and update the drivers for the card reader.

5.

Make sure the smart card reader is compliant with ISO 7816 Class A, B, and C.

6.

Reinsert the card reader with correct face as described in its documentation.

7.

Check reader function with a verified working card.

CAUTION: If the card reader has an in-use indicator light, do not insert or remove
memory cards while the light is flashing. Doing so may cause loss of data on the card
or may permanently damage the card reader.
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Speaker, headphone - audio issues

Symptoms
●

No sound from external or
internal speakers

●

Distorted sound, too soft, too
loud, intermittent

Possible causes
Volume turned down, sound card not recognized, malfunctioning hardware, electronic
interference.

Troubleshooting steps
1.

Remove any device connected to the Audio jack to enable the internal speaker.

2.

Close all open programs.

3.

Adjust volume by pressing Fn + F8/F9. Be sure that volume button light is not amber
(mute).
- or Adjust Windows volume control by clicking the speaker icon on the Windows taskbar. Be
sure that the sound is not muted.

4.

Verify that sound card is detected in Windows Device Manager.

5.

Reinstall the latest audio driver.

6.

Test audio device using HP PC Hardware Diagnostics (UEFI) tool (F2 > Component Tests
> Audio).

7.

Test with a verified working operating system. If issue is resolved, restore full operating
system.

8.

Test with verified working external speakers or headset.

9.

Reseat internal speaker connections.

10. Test with verified working internal speakers.
11. Replace internal speakers.
No sound from headphones

No sound from external speakers

1.

Adjust volume by pressing Fn + F8/F9. Be sure that volume button light is not amber
(mute). Or adjust Windows volume control by clicking the speaker icon on the Windows
taskbar. Be sure that the sound it not muted.

2.

Check headphone cable connection.

3.

Test with a verified working audio board.

4.

Replace audio board and verify the change.

1.

Verify that external speakers are turned on.

2.

Disconnect headphones from headphone jack.

3.

Adjust volume by pressing Fn + F8/F9. Be sure that volume button light is not amber
(mute).
- or Adjust Windows volume control by clicking the speaker icon on the Windows taskbar. Be
sure that the sound is not muted.

4.

Check for possible interference devices nearby that may impact the audio (cell phone or
portable communications handset.)
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Thunderbolt (TB)

Symptom

Possible causes

Thunderbolt device not working

BIOS, drivers, and user settings.
Troubleshooting steps
1.

Update to the latest BIOS and choose appropriate TB Port settings.

2.

Reset User Account Settings to default.

3.

Update Intel Thunderbolt software that includes firmware version (for TB controller), driver
version (operating system driver), and application version.

4.

Verify that TB device is detected in Windows Device Manager.

5.

Verify TB port, cable and connection.

6.

Test with a verified working TB board, if possible.

NOTE: Thunderbolt is new technology. Thunderbolt cable and Thunderbolt device must be
compatible with Windows. To determine whether your device is Thunderbolt Certified for
Windows, see https://thunderbolttechnology.net/products.
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Storage
NOTE:
●

Back up all critical data prior to drive troubleshooting.

●

Prior to contacting support, HP recommends that you run a drive (HDD, SSD, M.2 drive) test using the HP
PC Hardware Diagnostics (UEFI) tool on the suspected failed drive.

●

Diagnose the storage device using BIOS, Diagnostics built in the shipping image, or an external USB (HP
PC Diagnostics 3-in-1 USB Key).

●

The drive quick test is recommended to quickly (less than 10 minutes) identify the malfunctioning drive.
If the issue still exists, run Extensive Test (more than 2 hours, or loop mode, which will run until an error
occurs).

●

If any test fails, record failure code and contact support for instructions on how to order a replacement
storage device.

●

If all of the tests pass, the storage device is not damaged. As a rule, HP will not replace a storage device
under warranty that does not fail the HP Hard Drive Self-Test.

●

If there is no physical problem with the storage device (or memory), then try reinstalling the Windows
operating system to troubleshoot the problem.
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Hard drive/solid-state drive not recognized

Symptom

Possible causes

Hard drive is not recognized during
POST

Loose connection, faulty hard drive, faulty drive configuration/BIOS setting.
Troubleshooting steps
1.

Perform a hard reset (8. Hard reset on page 76).

2.

Reset BIOS to default.

3.

Verify storage device connection and flex cable. Reseat storage device and cable
connection. For multiple storage devices, keep the primary drive with the operating
system and remove other devices.

4.

Use the HP Hardware Diagnostics tool to verify the drive is recognized and test it.

5.

If the storage device fails diagnostics, record failure and have the drive replaced.

6.

Identify when the issue is related to software. If the storage device passes diagnostics,
test the drive on a verified working computer. If the failure follows the drive, reinstall
the operating system to make sure software is not an issue.

7.

Test with a verified working storage device. If it is still not recognized, the system board
is faulty.

NOTE: If the drive is seen in BIOS and Diagnostics, try a secure erase prior to replacing a
drive as this may resolve related issues.

No boot to operating system (no read/write error)

Symptoms
●

Post error message: Boot Device
not found (3F0)

●

Hang when booting to operating
system

Possible causes
Operating system, loose connection, faulty storage device, BIOS configuration, Secure Boot.
Troubleshooting steps
1.

Verify if Secure Boot is enabled in BIOS. Secure Boot prevents legacy boot devices from
starting the computer, including bootable CDs and DVDs. For more information, see HP
PCs - Secure Boot (Windows 8).

2.

Reset BIOS to default. Be sure that BIOS Boot Mode in Boot Option is set up properly
for bootable device and its operating system (i.e., UEFI Native for Windows 8).
Another example, choosing Legacy Boot Order for an UEFI device will cause "Boot
Device not found (3F0)" error.

Note
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3.

Verify storage device connection and flex cable. Reseat connection. For multiple
storage devices, keep the primary drive with the operating system and remove other
devices.

4.

Use PC Hardware Diagnostics tool to test. Record failure code and have the storage
device replaced.

5.

If there is no error, reinstall the operating system using HP Restore.

6.

Test with a verified working operating system storage device, if available.

If there is a hard drive POST error message, see POST Error Messages and User Actions
on page 126.

Read-write error

Symptoms
●

Post error message (i.e., error
code 301)

●

Hang when working on data, files,
documents

Note

Possible causes
Loose connection, faulty hardware.
Troubleshooting steps
1.

Perform a hard reset (8. Hard reset on page 76).

2.

Reset BIOS to default (9. Soft reset (Default Settings) on page 77).

3.

Verify drive connection and flex cable. Reseat connection (10. Reseat cables and
connections on page 77).

4.

Use the HP Hardware Diagnostics tool to test. If failed, record failure code and have the
storage device replaced.

5.

If no error with HP PC Hardware Diagnostics (UEFI) tool, try to repair the storage device
and its files in Windows (using command “CHKDSK /f /r /x”). Use HP Restore to
reinstall the operating system, if needed.

6.

Test with a verified working storage device. If it is not recognized, the system board is
faulty.

If there is a hard drive POST error message, see POST Error Messages and User Actions
on page 126.

Slow performance

Symptoms

Possible causes

Slow performance even when
performing small read/write
operations

Operating system files, storage device is full.
Troubleshooting steps
1.

Transfer data from the storage device to create more space. Microsoft recommends at
least 200 MB to sync system files.

2.

Perform disk defragmentation to consolidate fragmented data on the storage device so
it will work more efficiently.
NOTE:

Tips & tricks

Do not defrag an SSD.

For optimal system performance, you need to place your operating system and all of your
most commonly used applications and files in the fastest hard drive (solid-state drive) and
fastest areas on the drive (primary partition of 200 GB max).
See Improving System Performance. Also see Routine Maintenance for Performance
Improvement on page 128).

Blue screen (BSOD) error
Faulty storage device may cause blue screen error. Perform the drive tests using the HP Diagnostics Tool to
make sure the drive is functional. If all of the tests pass, see Common Blue Screen Error Messages
on page 128 for detailed troubleshooting steps.
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Noisy hard drive
IMPORTANT:

An SSD has no moving parts, so it does not make loud or clicking noise.

Depending on type and rotational speed, some hard drives will make more noise then others.
Not all noises are related to the fan or hard drive.

Symptoms

Possible causes

●

Loud noise from hard drive

BIOS, hard drive firmware, driver, faulty drive, power supply (AC adapter).

●

Clicking noise from hard drive

Troubleshooting steps

●

Still boots to operating system
and operates normally

1.

Update BIOS and hard drive firmware.

2.

Examine AC adapter to be sure that it is not faulty or overloaded. Disconnect all
peripherals (USB storages, dock, etc.).

3.

Remove hard drive to isolate the noise.

4.

Test the hard drive on a verified working computer if the noise continues. If the hard
drive makes the same noise or clicking sounds, the sounds are either normal sounds
for the hard drive or a fault with the hard drive.

5.

Verify original hard drive connection and flex cable. Reseat hard drive and connection.

6.

Run HP PC Hardware Diagnostics (UEFI). If failed, record failure code and have the hard
drive replaced.

7.

If no error with HP PC Hardware Diagnostics (UEFI), perform disk defragmentation
(some hard drives make a clicking noise when highly fragmented).

Tips & tricks

For optimal system performance, place your operating system and all of your most
commonly used applications and files on the fastest hard drive or solid-state drive and on
the fastest areas on the drive (primary partition of 200 GB max).
See Improving System Performance. Also, see Routine Maintenance for Performance
Improvement on page 128).
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Mechanical
Fan error message - 90B

Symptoms

Possible causes

Fan error 90B at boot

Defective fan; out-of-date BIOS.

CAUTION: May lead to system
shutdown, data loss or possible system
damage.

●

The system fan is not spinning or not spinning properly (loose connection, fan is stuck
or defective).

●

The temperature inside the case is too high, and the fan cannot spin fast enough to
remove the heat due to an obstruction to air flow.

Troubleshooting steps
General actions
1.

Update BIOS and drivers (4. Update BIOS and drivers on page 67) or reset BIOS to
default. BIOS may implement new fan characteristics and updates for other
components.

2.

Perform a hard reset (8. Hard reset on page 76). Performing a hard reset can reset
recorded thermal values in memory.

Thermal-related issue
1.

2.

Verify thermal condition:
a.

Check fan and connection. Reseat fan cable.

b.

Be sure that no obstructions or dust are in heat sink fan, fin, or vent.

c.

Test fan using HP PC Hardware Diagnostics (UEFI) tool (6. HP Hardware
Diagnostics and Tools on page 68). Be sure that the fan is not producing loud
noise and that fan blades spin correctly.

d.

Test with a verified working fan.

e.

Remove old thermal compound and pads, and replace properly with new pads.

Verify thermal solution
▲

Note

Use Thermal Monitor tool (available only to authorized service providers/
technicians) to run stress test (processor and GPU) and verify that thermal
sensors are within limits after thermal condition is serviced.

BIOS currently omits fan presence detection to shorten boot time delay less than four
seconds. Therefore, the fan error is generated based on previous boot to operating system
that found system fan error.
Fan often is part of thermal solution, including heat sink, fin/ muffler, and thermal grease.
Fan replacement requires reboot and fan function verification using HP PC Hardware
Diagnostics (UEFI) tool.

Common issues and possible solutions 119

See Reducing Heat Inside the PC to Prevent Overheating.

Noise (sound)

Symptoms

Possible causes

Computer emits abnormal noise

Aside from basic components (power adapter/supply, fan, speaker, hard drive, optical drive,
display panel, external devices), it is also common for electronic components to produce
noise.
Troubleshooting steps
1.

Inspect external power source and change to verified working one.

2.

Determine whether the noise comes from AC power adapter. Test with a verified
working AC adapter.

Disconnect external devices and all cables connected to the computer to isolate issue to
computer only.
Noisy fan

Determine whether the noise comes from the fan. Disconnect the fan briefly to isolate
whether noise originates from fan. If noise is absent with fan disconnected, refer to Fan runs
constantly on page 121.

Noisy hard drive

Determine whether the noise comes from the hard drive.
See Noisy hard drive on page 118.

Noisy optical drive

Noisy speaker

Noisy display

1.

Determine whether the noise comes from an optical drive.

2.

Remove CD/DVD from the optical drive.

1.

Determine whether the noise comes from speaker.

2.

Test with a verified working external headset/speaker.

Determine whether the noise comes from display panel (humming noise). Change display
frequency settings. See Display on page 100.

The section below is intended for authorized service providers/technicians.
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1.

After disassembling the chassis, inspect components of the interior for excessive wear
or damage.

2.

If noise issues persist, proceed with process of elimination for battery, AC adapter, or
boards.

Fan runs constantly

Symptoms

Possible causes

●

Fan never stops running

●

BIOS not up to date.

●

Generates heat

●

●

Decreased computer
performance

Thermal condition (fan, air flow)--fan may not be defective but must run constantly to
remove excess heat generated by electrical components.

●

Inappropriate configuration.

Troubleshooting steps
General actions
1.

Verify whether BIOS is set to Fan Always on while on AC Power F10 Setup. When
booting the computer, press F10 to open Setup, and then select Advanced > Built-In
Device Options Menu.

2.

Update BIOS and drivers (4. Update BIOS and drivers on page 67) and reset BIOS to
default. BIOS may implement new fan characteristics and updates for other
components.

3.

Perform a hard reset (8. Hard reset on page 76). Performing a hard reset can reset
recorded thermal values in memory.

Thermal-related issue
1.

2.

Verify fan is spinning. Reseat fan cable before moving to next step.
a.

Check fan and connection. Reseat fan cable.

b.

Be sure that no obstructions or dust are in heat sink fan, heat sink fin, or vent.

c.

Test fan using HP PC Hardware Diagnostics (UEFI) tool (6. HP Hardware
Diagnostics and Tools on page 68). Be sure that the fan is not producing loud
noise and that fan blades spin correctly.

d.

Test with a verified working fan.

e.

Replace the fan.

Verify thermal solution
Use Thermal Monitor tool (available only to authorized service providers/technicians)
(HP Thermal Monitor on page 71) to run stress test (processor and GPU) and verify that
thermal sensors are within limits after thermal condition is serviced.

User configuration
Change Power Options in Windows (i.e., choosing Balanced mode instead of High
performance). High performance and extensive graphics may cause the fan run constantly
to release the heat.
Notes

BIOS currently omits fan presence detection to shorten boot time delay less than four
seconds. Therefore, the fan error is generated based on previous boot to operating system
that found system fan error.
Fan often is part of thermal solution, including heat sink, heat sink fin/muffler, and thermal
grease. Fan replacement requires reboot and fan function verification using HP PC Hardware
Diagnostics (UEFI) tool.
For more information, see the following links:
●

HP Notebook PCs - Fan is Noisy and Spins Constantly, PC is Warmer than Normal.

●

Reducing Heat Inside the PC to Prevent Overheating.

●

Improving System Performance.
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Thermal shutdown (hot)

Symptoms

Possible causes

Similar to fan runs constantly issue
(Fan runs constantly on page 121)

BIOS not up to date, thermal condition (fan, air flow)

●

System shutdown

●

Abnormal heat

●
●

Troubleshooting steps
1.

Update BIOS and drivers (4. Update BIOS and drivers on page 67) and reset BIOS to
default. BIOS may implement new fan characteristics and updates for other component.

Continually running fan

2.

Decreased computer
performance

Perform a hard reset (8. Hard reset on page 76). Performing a hard reset can reset
recorded thermal values in memory.

3.

Determine whether you are using a correct AC adapter.

4.

Be sure to turn power off completely when putting a notebook in a travel bag.

Thermal-related issue
1.

2.

Verify thermal condition:
a.

Check fan and connection. Reseat fan cable.

b.

Be sure that no obstructions or dust are in heat sink fan, fin, or vent.

c.

Be sure that the notebook is not sitting on a hot surface that blocks vent intakes.

d.

Test fan using HP PC Hardware Diagnostics (UEFI) tool (6. HP Hardware Diagnostics
and Tools on page 68). Be sure that the fan is not producing a loud noise and that
fan blades spin correctly.

e.

Test with a verified working fan.

f.

Remove old thermal compound and pads, and replace properly with new pads.

Verify thermal solution:
○

Note

Use Thermal Monitor tool (available only to authorized service providers/
technicians) to run stress test (processor and GPU) and verify that thermal sensors
are within limits after thermal condition is serviced.

See Reducing Heat Inside the PC to Prevent Overheating.

Stuck power button

Symptoms

Possible causes

●

Rear power indicator light is on

Sticky or defective power button.

●

Will not turn on when power
button is pressed

Troubleshooting steps

●

Automatically powers on

General actions
1.

Perform a hard reset (8. Hard reset on page 76).

2.

Perform a soft reset if system can turn on.

The sections below are intended for authorized service providers/technicians.
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1.

Disassemble the unit.

2.

Inspect power button on the top cover and on the system board to make sure these
buttons moves freely.

Additional information
The following sections provide additional information that can be used during the troubleshooting process.

Acronyms
The following acronyms are used in this chapter.
Blue screen (BSOD)—A Windows error screen that can occur if a problem causes your computer to shut down
or restart unexpectedly. When you experience this type of error, you will not be able to see items such as the
Start menu or the taskbar when your computer is turned on. Instead you might see a blue screen with a
message that your computer ran into a problem and needs to restart.
CPU—Central processing unit
DIMM—Dual in-line memory module
Daughterboard—Type of circuit board that plugs into or is attached to the system board or similar expansion
card to extend its features and services.
GPU–Graphics processor unit
GTS–General Troubleshooting Step
HDD–Hard drive
KB–Keyboard
LVDS–Low-Voltage Differential Signaling
MSG–Maintenance and Service Guide
mWS–Mobile Workstations
WS–Workstations
OS–Operating system
PC–Personal computer
POST–Power-On Self-Test
SSD–Solid-state drive
TSG–Troubleshooting Guide
UEFI–Unified Extensible Firmware Interface
WLAN–Wireless local area network
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Blinking lights and boot error codes
The information below is from the white paper HP Business Notebook and Desktop PC F10 Setup, 2014
Business PC models.
In some cases, when the host processor is not executing code or does not have the necessary code to drive
the display, light blink codes inform you of a problem.
Table 7-6 Boot-error codes
Blink codes

Error

Amber battery light: blinks 1 Hz continuously

Embedded Controller unable to load firmware

Caps/num lock lights = 1 blink

Processor not executing code

Caps/num lock lights = 2 blinks

BIOS recovery code unable to find valid BIOS recovery image

Caps/num lock lights = 3 blinks

Memory module error

Caps/num lock lights = 4 blinks

Graphics controller error

Caps/num lock lights = 5 blinks

System board error

Caps/num lock lights = 6 blinks

Intel Trusted Execution Technology (TXT) Error

Caps/num lock lights = 7 blinks

Sure Start unable to find valid BIOS Boot Block image

Caps/num lock lights = 8 blinks

Sure Start has identified a problem (Manual Recovery Policy Set)

Processor not executing code
This computer has experienced a problem due to the failure of certain code to execute, resulting in a failed
startup of the processor. The issue could be related to the processor or the system board in the computer. If
the processor is socketed, be sure that the processor is seated correctly in the socket. If this error reoccurs,
refer to General troubleshooting steps on page 63.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink once followed by a pause, and then continue in a repeating pattern.

BIOS recovery code unable to find valid BIOS recovery image
This computer has experienced a problem in locating a valid BIOS image, resulting in a failed startup. This
problem may be resolved by placing a clean copy of the system BIOS on a USB key or in the appropriate
storage device directory and performing a reboot. If this error reoccurs, refer to General troubleshooting
steps on page 63.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink twice followed by a pause, and then continue in a repeating pattern.

Memory module error
This computer has experienced a memory initialization problem resulting in a failed startup. This issue may
be related to the memory modules in the computer. This problem may be resolved by ensuring that memory
modules are correctly inserted and seated. If this error reoccurs, a service event is required to determine the
source of the error (memory modules or system board) and take the appropriate corrective action.
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NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink three times followed by a pause, then continue in a repeating pattern.

Graphics Controller Error (No Controller)
This computer has experienced a graphics controller initialization problem resulting in a failed startup. This
issue may be related to the graphics controller in your machine. This problem may be resolved by ensuring
that the graphics controller module is seated correctly in machines with modular graphics. If this error
reoccurs, a service event is required to identify the source of the error and take the appropriate corrective
action.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink four times followed by a pause, then continue in a repeating pattern.

Failure - System Board Error
This computer has experienced a system board initialization problem resulting in a failed startup. This issue
may be related to the system board in the computer. A service event is required to identify the source of the
error and take the appropriate corrective action.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink five times followed by a pause, then continue in a repeating pattern.

Intel Trusted Execution Technology (TXT) Error
This computer has experienced a problem related to the Intel Trusted Execution Technology resulting in a
failed startup. The error occurs when all of the following are true:
●

The Intel Trusted Execution Technology (TXT) has been enabled on the computer.

●

Policies have been set to prevent startup if the BIOS measurement has changed.

●

The BIOS measurement has changed.

For more information about Intel TXT, go to http://www.intel.com/content/dam/www/public/us/en/
documents/white-papers/trusted-execution-technology-security-paper.pdf.
A service event is required to resolve this issue.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink six times followed by a pause, then continue in a repeating pattern.

Sure Start unable to find valid BIOS Boot Block image
This computer has experienced a problem in locating a valid BIOS image, resulting in a failed startup. A service
event is required to identify the source of the error and take appropriate corrective action.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink seven times followed by a pause, then continue in a repeating pattern.
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Sure Start has identified a problem (Manual Recovery Policy Set)
This computer has experienced a problem in locating a valid BIOS image, resulting in a failed startup. HP Sure
Start will normally repair this type of issue; however, on this computer HP Sure Start has been configured to
operate in manual mode key sequence. To proceed with the repair, press and hold the following keys: <ESC>
+<UP arrow>+<DOWN arrow>. To avoid the need for this manual recovery step, set the HP Sure Start recovery
policy to automatic. If this error reoccurs, a service event is required to identify the source of the error and
take appropriate corrective action.
NOTE: The computer will attempt to notify you of this problem through a series of blinking lights. When you
attempt to turn on the computer from an “Off” or “Hibernated” state, lights associated with the caps lock and
num lock keys will both blink eight times followed by a pause, then continue in a repeating pattern.

POST Error Messages and User Actions
Test description

Failure descriptions

Error code

Possible user actions

Product
information

Invalid value

00A

Contact support for assistance.

Startup test

Memory module

200

Attempt to reseat the memory module and then repeat the test.
See Overview of How to Troubleshoot Problems When a Computer Does
Not Start Up or Boot Properly for details on troubleshooting issues related
to the memory module.
If the memory module still fails, contact support.

Startup test

Hard Disk 1 SMART

301

Attempt to reseat the storage device and repeat the test.
The drive may have failed. Contact support for assistance.

Startup test

Hard Disk 2 SMART

302

The drive may have failed. Contact support for assistance.

Startup test

Hard Disk 1 Quick

303

The drive may have failed. Contact support for assistance.

Startup test

Hard Disk 2 Quick

304

The drive may have failed. Contact support for assistance.

Run-in test

Memory module

200

Attempt to reseat the memory module and then repeat the test.
See Overview of How to Troubleshoot Problems When a Computer Does
Not Start Up or Boot Properly for details on troubleshooting issues related
to the memory module.
If the memory module still fails, contact support.

Run-in test

Hard Disk 1 SMART

301

Attempt to reseat the storage device and repeat the test.
The drive may have failed. Contact support for assistance.

Run-in test

Hard Disk 2 SMART

302

The drive may have failed. Contact support for assistance.

Run-in test

Hard Disk 1 Quick

303

The drive may have failed. Contact support for assistance.

Run-in test

Hard Disk 2 Quick

304

The drive may have failed. Contact support for assistance.

Hard Disk Test

Hard Disk 1 SMART

301

Attempt to reseat the storage device and repeat the test.
The drive may have failed. Contact support for assistance.

Hard Disk Test

Hard Disk 2 SMART

302

The drive may have failed. Contact support for assistance.

Hard Disk Test

Hard Disk 1 Quick

303

The drive may have failed. Contact support for assistance.

Hard Disk Test

Hard Disk 2 Quick

304

The drive may have failed. Contact support for assistance.
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Hard Disk Test

Hard Disk 1 Full

305

The drive may have failed. Contact support for assistance.

Hard Disk Test

Hard Disk 2 Full

306

The drive may have failed. Contact support for assistance.

Boot Device
Manager

Boot device not found

3F0

Indicates a potential problem with the storage device. Please run the drive
test.
See Testing a Hard Disk using the Built in Self Test for more information.

Boot Device
Manager

Hard Disk 1 Error

3F1

Indicates a potential problem with the storage device. Run the drive test.

Boot Device
Manager

Hard Disk 2 Error

Boot Device
Manager

Hard Disk 1 SMART

Boot Device
Manager

Hard Disk 2 SMART

BIOS Recovery

BIOS Recovery
Occurred

500

This message indicates that BIOS recovery was completed successfully. No
further action is required.

BIOS Application

BIOS Application Error

501

The BIOS installation may have become corrupted. Download the latest
version of the BIOS and install it. See 4. Update BIOS and drivers
on page 67 for more information.

See Testing a Hard Disk using the Built in Self Test for more information.
3F2

Indicates a potential problem with the storage device. Run the drive test.
See Testing a Hard Disk using the Built in Self Test for more information.

301

Indicates a potential problem with the storage device. Run the drive test.
See Testing a Hard Disk using the Built in Self Test for more information.

302

Indicates a potential problem with the storage device. Run the drive test.
See Testing a Hard Disk using the Built in Self Test for more information.

If reinstalling the BIOS fails, contact support for further assistance.
CMOS Recovery

CMOS Recovery
Occurred

502

This message indicates that CMOS recovery was completed successfully.
No further action is required.

Battery Check

Primary Battery
Replace

601

This indicates that the primary battery has very low capacity. See
Checking the Status of the Battery for details on using the HP Support
Assistant to verify the battery capacity and, if necessary, order a
replacement.

Battery Check

Secondary Battery
Replace

602

This indicates that the secondary battery has very low capacity. See
Checking the Status of the Battery for details on using the HP Support
Assistant to verify the battery capacity and, if necessary, order a
replacement.

Wireless Module

Not installed or
responding

701

Reseat the wireless LAN adapter module, if your notebook supports it.

Fan not operating
correctly

90B

Fan

Because seating or reseating a wireless LAN adapter is unique to each
computer model. For more information, see the chapter titled “Removal
and replacement procedures for Customer Self-Repair parts.”
The system fan may be malfunctioning.
For information on troubleshooting heat-related issues, see HP Notebook
PCs - Fan is Noisy and Spins Constantly, PC is Warmer than Normal.
A hard reset can sometimes restore the system fan to working order. See
Use Hard Reset to Resolve Hardware and Software Issues for details.
If the system fan continues to malfunction, contact support.
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Routine Maintenance for Performance Improvement
See HP Notebook PCs - Improving the Performance of Your Computer.
The following table presents a summary of the suggested times for performing the routine maintenance
tasks described in this document.
Tasks

Weekly

Perform a system tune up.

X

Run Windows Update.

X

Scan for and remove viruses.

X

Scan for and remove spyware and adware.

X

Empty the Recycle Bin.

X

Delete temporary Internet files.

X

Monthly

Back up user files.

X

Create a restore point.

X

Defragment the storage device.

X

Run Scan Disk.

X

Occasionally

Clean the exterior of the computer.

X

Close programs that are not being used.

X

Prevent programs from loading at startup.

X

Common Blue Screen Error Messages
Error message list
The following image shows an example of one possible “Bug Check (Blue Screen) Code Reference” from
Microsoft:

The hexadecimal number following the word "STOP" is called the bug check code or Stop code. This is the
most important item on the screen.

Bug check symbolic names
Each bug check code also has an associated symbolic name. In the example, the screen shows bug check 0x79
(MISMATCHED_HAL).
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Microsoft general troubleshooting of Windows bug check codes
●

If you recently added hardware to the system, try removing or replacing it. Or check with the
manufacturer to see if any patches are available.

●

Try running HP PC Hardware Diagnostics (UEFI).

●

Check with the manufacturer to see if an updated system BIOS or firmware is available.

●

Be sure that any expansion board is properly seated and all cables are completely connected.

●

Confirm that any new hardware that is installed is compatible with the installed version of Windows.

●

If new device drivers or system services have been added recently, try removing or updating them.
NOTE: Use safe mode when removing or disabling components. Safe mode loads only the minimum
required drivers and system services during the Windows startup. To enter safe mode, restart your
computer and press F8 at the menu that displays the operating system choices. At the resulting
Windows Advanced Options menu, choose Safe Mode.

●

Run a virus detection program. Viruses can infect all types of storage devices formatted for Windows,
and resulting drive corruption can generate system bug check codes. Be sure that the virus detection
program checks the Master Boot Record for infections.

●

Verify that the system has the latest service pack installed. To detect which service pack, if any, is
installed on your system, click Start, click Run, type winver, and then press Enter. The About Windows
dialog box displays the Windows version number and the version number of the service pack, if one has
been installed.

●

Disable BIOS memory options such as caching or shadowing.

●

Check the System Log and Application Log in Event Viewer to see if any additional error messages have
been logged recently. These might pinpoint the cause of the error.

Use Windows Debugging Tool
The Windows Debugger is one of the primary tools used by Microsoft software developers to analyze and
resolve errors that result in memory dumps. Use the tool to determine the cause of the error. Follow general
steps for downloading, setting up, and using the Windows 10 debugging tool. A similar process is used for
Windows 7 or Windows 8.
NOTE: The following screen shots provide only an example of the tool. Specifics shown are not
representative of all applications of the debugging tool. This is a Microsoft tool supported by Microsoft.
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Windows Software Development Kit (SDK)
1.

Download the SDK from the following link:
https://msdn.microsoft.com/en-us/windows/desktop/bg162891.aspx

2.

Set up the SDK in the configuration window (Windows 10 shown).

3.

Select features to install.
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4.

Run the SDK as an administrator.

5.

Set the symbol path. Select File > Symbol File Path.
●

In the Symbol path box, type SRV*C:\Windows\symbol_cache*http://
msdl.microsoft.com/download/symbols.

●

Save the workspace.
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6.

Open the crash dump file.

132 Chapter 7 Troubleshooting guide

7.

Analyze the file. In the following memory dump sample, look for Bug Check 0x3B. The ATIKMAG driver
needs to be investigated for further root cause.
Lookup for Bug Check 0xC2.
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Display Issue: Pixel Anomalies
All HP notebook displays adhere to strict quality and reliability specifications. A small percentage of display
panels may have minor cosmetic manufacturing anomalies or irregularities such as bright or dark dots in the
viewable area. These cosmetic imperfections are common to all display panel types and are not specific to
any HP model or product line.
All display panel defects should be examined at the highest possible resolution using both the brightest and
darkest possible backgrounds, because some sub-pixel failures may not be readily visible under certain
conditions.
●

Type 1: Bright dot on a dark background = Always On

●

Type 2: Dark dot on a bright background = Always Off

●

Combination = in any combination and any color that are always on or off

Use the HP PC Hardware Diagnostics (UEFI) tool to determine numbers of pixels and their distance. HP uses
the following set of criteria when damaged displays are submitted for warranty coverage.
Source: HP Notebook PCs and Tablets - About LCD Panel Defects and Terminology for Notebook PCs and
Tablets
Table 7-7 Electrical defect allowances
Panel resolution

Accept

Reject

N ≤ 2 Type 1

N ≥ 3 Type 1

Sub-pixel faults
VGA, SVGA, SD, WSVGA, XGA, 720p, SD+, WXGA, HD

N ≤ 2 Type 2
WXGA+, SXGA+, HD+, SXGA+

N ≤ 3 Type 1

N ≥ 4 Type 1

N ≤ 3 Type 2
WSXGA+, UXGA, FHD, WUXGA

N ≤ 4 Type 1

N ≥ 5 Type 1

N ≤ 4 Type 2
QHD, QHD+, WQXGA, UD

N ≤ 5 Type 1

N ≥ 6 Type 1

N ≤ 5 Type 2
Electrical defect clusters (defects within a 5x5 pixel block)
Minimum distance between ANY allowable defects (unless otherwise specified)

S ≥ 25 mm

S < 25 mm

Cluster with 2 or more sub-pixels with sub-pixel faults

Not allowed

Dim lines

Not allowed

Cross line(s) on/off

Not allowed

Horizontal line(s) on/off

Not allowed

Vertical line(s) on/off

Not allowed

NOTE: All LCD panel defects should be examined at the highest possible resolution using both the brightest
and darkest possible backgrounds, as some sub-pixel failures may not be readily visible under certain
conditions.
NOTE:

Contact support for assistance if issues are not listed.
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Cable management
Proper routing of the internal cables is critical to the operation of the computer. Follow good cable
management practices when removing and installing components.
●

Handle cables with care to avoid damage.

●

Apply only the tension required to seat or unseat cables during insertion or removal from the connector.

●

When possible, handle cables by the connector or pull-strap.

●

Route cables in such a way that they cannot be caught or snagged by parts being removed or replaced.

●

Keep cables away from direct contact with major heat sources, such as the heat sink. (Some air flow
guides have a cable guide that lets you route cables safely around the heat sink.)

●

Do not jam cables on top of daughterboards or memory modules (DIMMs). Circuit cards and DIMMs are
not designed to take excessive pressure.

●

Keep cables clear of any movable or rotating parts (such as a fan) to prevent them from being cut or
crimped when the component is lowered into its normal position.

●

In all cases, avoid bending or twisting the cables. Do not bend any cable sharply. A sharp bend can break
the internal wires.

●

Do not rely on components like the keyboard or service door to push cables down internally. Always
position the cables to lay properly by themselves or in the cable guides and chassis areas designed for
cable routing.

CAUTION: Always release connector latch before removing the cable. Otherwise, pulling the cable could
damage the cable pins and result in a failed device.
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Connector types
IMPORTANT:

Connector pins and connector gold fingers should not be touched directly with bare hands.

There are several different types of connectors on the system board with different requirements for cable
removal or insertion.
Flex cable
When connecting flex cables, push the cable completely, evenly into the connector.
When removing flex cables from a ZIF connector on the system board, always follow these steps:
1.

Squeeze on the top of the retaining latch attached to the cable end of the connector.

2.

Grasp the cable end of the connector and pull it straight out.

CAUTION: Always release connector latch before removing the cable. Otherwise, pulling the cable could
damage the cable pins and result in a failed device.

Horizontal installation cable
Use flat tool to pull connector evenly. Do not pull on cable to remove.
Slide connector into receptacle on same horizontal plane as board and use flat tool to push evenly into
receptacle.
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Multi-pin horizontal insert connector (LVDS cable to display panel)
Insert procedure:
1.

Slide connector evenly into receptacle on same horizontal plane as PCB connector.

2.

Pull lock bar to insert and push both side connector horizontally to firmly lock.

3.

Tape down lock bar over the panel to hold in position.

Reverse the procedure above to remove the connector:
1.

Remove tape.

2.

Pull up bar (pull tape) and release the lock with the PCB connector.

3.

Pull to the direction in parallel with PCB to withdraw the connector.

Multi-pin vertical insert connector (LVDS cable to system board)
●

Remove the connector gasket prior to removing the connector.

●

Use flat tool under the connector to remove evenly. Do not pull on the cable to remove.

●

Press evenly when reseating/reconnecting/installing the connector.

For more information about cable management, see Cable management on page 135.

Additional information 137

8

Computer Setup (BIOS), TPM, and HP Sure
Start in Windows 7

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.
To start Computer Setup, follow these steps:
▲

Start Computer Setup.
●

Computers or tablets with keyboards:
▲

●

Turn on or restart the computer, and when the HP logo appears, press f10 to enter Computer
Setup.

Tablets without keyboards:
▲

Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F10 to enter Computer Setup.

Navigating and selecting in Computer Setup
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or
use a pointing device to select the item.
NOTE: On tablets without keyboards, you can use your finger to make selections.

●

To scroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or
use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow
the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Select the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Select Main, select Ignore Changes and Exit, and then press enter.

●

To save your changes and exit Computer Setup menus:
Select the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Start Computer Setup. See Starting Computer Setup on page 138.

2.

Select Main, and then select Apply Factory Defaults and Exit.
NOTE: On select products, the selections may display Restore Defaults instead of Apply Factory
Defaults and Exit.

3.

Follow the on-screen instructions.

4.

To save your changes and exit, select the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.
– or –
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE:

Your password settings and security settings are not changed when you restore the factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version
To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on your
computer.
BIOS version information (also known as ROM date and System BIOS) can be accessed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup. See Starting Computer Setup on page 138.

2.

Select Main, and then select System Information.

3.

To exit Computer Setup without saving your changes, select the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
– or –
Select Main, select Ignore Changes and Exit, and then press enter.

To check for later BIOS versions, see Downloading a BIOS update on page 140.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Access Help and Support by selecting Start > All Programs > HP Help and Support > HP Support
Assistant.

2.

Make the selection for updates.

3.

Follow the on-screen instructions.

4.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your storage device.

b.

Follow the on-screen instructions to download your selection to the storage device.
Make a note of the path to the location on your storage device where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.
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NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:
1.

Select Start > Computer.

2.

Select your storage device designation. The storage device designation is typically Local Disk (C:).

3.

Using the storage device path you recorded earlier, open the folder that contains the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your storage device.

Changing the boot order using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Access the Boot Device Options menu:
●

Computers or tablets with keyboards:
▲

●

Tablets without keyboards:
▲

2.

Turn on or restart the computer, and when the HP logo appears, press f9 to enter the Boot
Device Options menu.

Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F9 to enter the Boot Device Options menu.

Select a boot device, then press enter.

TPM BIOS settings (select products only)
IMPORTANT: Before enabling Trusted Platform Module (TPM) functionality on this system, you must ensure
that your intended use of TPM complies with relevant local laws, regulations and policies, and approvals or
licenses must be obtained if applicable. For any compliance issues arising from your operation/usage of TPM
which violates the above mentioned requirement, you shall bear all the liabilities wholly and solely. HP will
not be responsible for any related liabilities.
TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup
(BIOS).
NOTE:

If you change the TPM setting to Hidden, TPM is not visible in the operating system.

To access TPM settings in Computer Setup:
1.

Start Computer Setup. See Starting Computer Setup on page 138.

2.

Select Security, select TPM Embedded Security, and then follow the on-screen instructions.
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Using HP Sure Start (select products only)
Select computer models are configured with HP Sure Start, a technology that monitors the computer's BIOS
for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start automatically restores
the BIOS to its previously safe state, without user intervention.
HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default
configuration. The default configuration can be customized by advanced users.
To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your
country. Select Drivers & Downloads, and then follow the on-screen instructions.
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9

Computer Setup (BIOS), TPM, and HP Sure
Start in Windows 10

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.
To start Computer Setup, follow these steps:
▲

Start Computer Setup.
●

Computers or tablets with keyboards:
▲

●

Turn on or restart the computer, and when the HP logo appears, press f10 to enter Computer
Setup.

Tablets without keyboards:
▲

Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F10 to enter Computer Setup.

Navigating and selecting in Computer Setup
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or
use a pointing device to select the item.
NOTE: On tablets without keyboards, you can use your finger to make selections.

●

To scroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or
use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow
the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Select the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Select Main, select Ignore Changes and Exit, and then press enter.

●

To save your changes and exit Computer Setup menus:
Select the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Start Computer Setup. See Starting Computer Setup on page 143.

2.

Select Main, and then select Apply Factory Defaults and Exit.
NOTE: On select products, the selections may display Restore Defaults instead of Apply Factory
Defaults and Exit.

3.

Follow the on-screen instructions.

4.

To save your changes and exit, select the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.
– or –
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE:

Your password settings and security settings are not changed when you restore the factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version
To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on your
computer.
BIOS version information (also known as ROM date and System BIOS) can be accessed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup. See Starting Computer Setup on page 143.

2.

Select Main, and then select System Information.

3.

To exit Computer Setup without saving your changes, select the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
– or –
Select Main, select Ignore Changes and Exit, and then press enter.

To check for later BIOS versions, see Downloading a BIOS update on page 145.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Type support in the taskbar search box, and then select the HP Support Assistant app.
– or –
Select the question mark icon in the taskbar.

2.

Select Updates, and then select Check for updates and messages.

3.

Follow the on-screen instructions.

4.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your storage device.

b.

Follow the on-screen instructions to download your selection to the storage device.
Make a note of the path to the location on your storage device where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.
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NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:
1.

Type file in the taskbar search box, and then select File Explorer.

2.

Select your storage device designation. The storage device designation is typically Local Disk (C:).

3.

Using the storage device path you recorded earlier, open the folder that contains the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your storage device.

Changing the boot order using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Access the Boot Device Options menu:
●

Computers or tablets with keyboards:
▲

●

Tablets without keyboards:
▲

2.

Turn on or restart the computer, and when the HP logo appears, press f9 to enter the Boot
Device Options menu.

Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F9 to enter the Boot Device Options menu.

Select a boot device, then press enter.

TPM BIOS settings (select products only)
IMPORTANT: Before enabling Trusted Platform Module (TPM) functionality on this system, you must ensure
that your intended use of TPM complies with relevant local laws, regulations and policies, and approvals or
licenses must be obtained if applicable. For any compliance issues arising from your operation/usage of TPM
which violates the above mentioned requirement, you shall bear all the liabilities wholly and solely. HP will
not be responsible for any related liabilities.
TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup
(BIOS).
NOTE:

If you change the TPM setting to Hidden, TPM is not visible in the operating system.

To access TPM settings in Computer Setup:
1.

Start Computer Setup. See Starting Computer Setup on page 143.

2.

Select Security, select TPM Embedded Security, and then follow the on-screen instructions.
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Using HP Sure Start (select products only)
Select computer models are configured with HP Sure Start, a technology that monitors the computer's BIOS
for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start automatically restores
the BIOS to its previously safe state, without user intervention.
HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default
configuration. The default configuration can be customized by advanced users.
To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your
country. Select Drivers & Downloads, and then follow the on-screen instructions.
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10 Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic
tests to determine whether the computer hardware is functioning properly. The tool runs outside the
operating system so that it can isolate hardware failures from issues that are caused by the operating system
or other software components.
When HP PC Hardware Diagnostics (UEFI) detects a failure that requires hardware replacement, a 24-digit
Failure ID code is generated. This ID code can then be provided to support to help determine how to correct
the problem.
NOTE: To start diagnostics on a convertible computer, your computer must be in notebook mode and you
must use the keyboard attached.
To start HP PC Hardware Diagnostics (UEFI), follow these steps:
1.

Turn on or restart the computer, and quickly press esc.

2.

Press f2.
The BIOS searches three places for the diagnostic tools, in the following order:
a.

Connected USB drive
NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 148.

3.

b.

Hard drive

c.

BIOS

When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the
on-screen instructions.

NOTE:

If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only, and you
must use a Windows computer to download and create the HP UEFI support environment because only .exe
files are offered.
There are two options to download HP PC Hardware Diagnostics to a USB device.
Download the latest UEFI version
1.

Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2.

In the HP PC Hardware Diagnostics section, click the Download link, and then select Run.

Download any version of UEFI for a specific product
1.

Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

2.

Click Drivers & Downloads.
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3.

Use the categories listed to find your product.
– or –
Click Find Now to let HP automatically detect your product.

4.

Select your computer, and then select your operating system.

5.

In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version
you want.
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11 Backup and recovery in Windows 7
Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you
ever need to. These tools will help you return your computer to a proper working state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7
operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original
operating system in cases where the storage device is corrupted or has been replaced. The Driver
Recovery DVD installs specific drivers and applications. See Creating recovery media with HP Recovery
Disc Creator on page 150.

2.

Use Windows Backup and Recovery tools to perform the following:
●

Back up individual files and folders

●

Back up your entire storage device (select models only)

●

Create system repair discs (select models only) with the installed optical drive (select models only)
or an optional external optical drive

●

Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details
about the tools provided, see Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.
In case of system failure, you can use the backup files to restore the contents of your computer. See Backing
up your information on page 151.

Guidelines
●

When creating recovery media or backing up to discs, use any of the following types of discs (purchased
separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type
of optical drive you are using.

●

Be sure that the computer is connected to AC power before you start the recovery media creation
process or the backup process.

Creating recovery media with HP Recovery Disc Creator
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. After
you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. This
recovery media allows you to reinstall your original operating system as well as select drivers and
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applications if the storage device becomes corrupted. HP Recovery Disc Creator can create two kinds of
recovery DVDs:
●

Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

●

Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media
NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that
media will not be available after you create a Windows DVD.
To create the Windows DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Windows disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process.

Backing up your information
You should create system repair media and your initial backup immediately after initial system setup. As you
add new software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. You should also create Windows system repair media (select models only) which
can be used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and
Support.
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To create a backup using Windows Backup and Restore:
NOTE:

The backup process may take over an hour, depending on file size and the speed of the computer.

1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models only), or
create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you have
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent
Windows from starting correctly.

●

f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard
drive image. The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you
previously created (select models only), you must purchase Windows 7 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 7 operating system
media on page 153.

Using the Windows recovery tools
Using the Windows recovery tools, you can:
●

Recover individual files

●

Restore the computer to a previous system restore point

●

Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these topics
in Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and
Support.
To recover information you previously backed up:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models only),
or your files.

To recover your information using Startup Repair, follow these steps:
CAUTION: Some Startup Repair options will completely erase and reformat the storage device. All files you
have created and any software installed on the computer are permanently removed. When reformatting is
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities
from the backup used for recovery.
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1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition.
To check for the Windows partition, select Start > Computer.
NOTE: If the Windows partition is not listed, you must recover your operating system and programs
using the Windows 7 operating system DVD and the Driver Recovery media. For additional information,
see Using Windows 7 operating system media on page 153.

3.

If the Windows partition is listed, restart the computer, and then press f8 before the Windows operating
system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start > Help
and Support.

Using f11 recovery tools (select models only)
CAUTION: Using f11 completely erases storage device contents and reformats the storage device. All files
that you have created and any software that you have installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
To recover the original storage device image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer, click
Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and programs
using the Windows 7 operating system media and the Driver Recovery media. For additional information,
see Using Windows 7 operating system media on page 153.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the ESC
key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using Windows 7 operating system media
If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the
operating system.
To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases storage device contents and
reformats the storage device. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you restore
the operating system, as well as drivers, software, and utilities.
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To initiate recovery using a Windows 7 operating system DVD:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before
the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

After the repair is completed:
1.

Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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12 Backing up, restoring, and recovering in
Windows 10
This chapter provides information about the following processes. The information in the chapter is standard
procedure for most products.
●

Creating recovery media and backups

●

Restoring and recovering your system

For additional information, refer to the HP Support Assistant app.
▲

Type support in the taskbar search box, and then select the HP Support Assistant app.
‒ or –
Click the question mark icon in the taskbar.

IMPORTANT: If you will be performing recovery procedures on a tablet, the tablet battery must be at least
70% charged before you start the recovery process.
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning any recovery process.

Creating recovery media and backups
The following methods of creating recovery media and backups are available on select products only. Choose
the available method according to your computer model.
●

Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall
the original operating system in cases where the storage device is corrupted or has been replaced. For
information on creating recovery media, see Creating HP Recovery media (select products only)
on page 155. For information on the recovery options that are available using the recovery media, see
Using Windows tools on page 156.

●

Use Windows tools to create system restore points and create backups of personal information.
For more information, see Recovering using HP Recovery Manager on page 157.
NOTE: If storage is 32 GB or less, System Restore is disabled by default.

Creating HP Recovery media (select products only)
If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu,
select File Explorer, and then select This PC.
●

If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery
media for your system from support. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.
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You can use Windows tools to create system restore points and create backups of personal information,
see Using Windows tools on page 156.
●

If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be
used to perform system recovery if the storage device becomes corrupted. System recovery reinstalls
the original operating system and software programs that were installed at the factory and then
configures the settings for the programs. HP Recovery media can also be used to customize the system
or restore the factory image if you replace the storage device.
–

Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

–

HP Recovery Manager examines the computer and determines the required storage capacity for
the media that will be required.

–

To create recovery discs, your computer must have an optical drive with DVD writer capability, and
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a highquality blank USB flash drive.

–

If your computer does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs. If you use an external optical drive, it must be connected
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

–

Be sure that the computer is connected to AC power before you begin creating the recovery media.

–

The creation process can take an hour or more. Do not interrupt the creation process.

–

If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue.

To create HP Recovery media:
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps.
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 157.

Using Windows tools
You can create recovery media, system restore points, and backups of personal information using Windows
tools.
NOTE:

If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get started app.
▲

Select the Start button, and then select the Get started app.
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Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:
IMPORTANT:
●

Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information see the Get started app.
▲

●

Not all methods are available on all products.

Select the Start button, and then select the Get started app.

If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/or
applications option (select products only) of HP Recovery Manager to reinstall the individual application
or driver.
▲

Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers
and/or applications, and then follow the on-screen instructions.

●

If you want to recover the Windows partition to original factory content, you can choose the System
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media.
For more information, see Recovering using HP Recovery Manager on page 157. If you have not already
created recovery media, see Creating HP Recovery media (select products only) on page 155.

●

On select products, if you want to recover the computer's original factory partition and content, or if you
have replaced the storage device, you can use the Factory Reset option of HP Recovery media. For more
information, see Recovering using HP Recovery Manager on page 157.

●

On select products, if you want to remove the recovery partition to reclaim storage device space, HP
Recovery Manager offers the Remove Recovery Partition option.
For more information, see Removing the HP Recovery partition (select products only) on page 159.

Recovering using HP Recovery Manager
HP Recovery Manager software allows you to recover the computer to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only). If you have not already created recovery media, see Creating HP Recovery
media (select products only) on page 155.

What you need to know before you get started
●

HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this computer, you must either download the software from the manufacturer's website or reinstall
the software from the media provided by the manufacturer.
IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct
computer issues.

●

HP Recovery media must be used if the computer storage device fails. If you have not already created
recovery media, see Creating HP Recovery media (select products only) on page 155.

●

To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 155.

●

If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not
work, you can obtain recovery media for your system from support. See the Worldwide Telephone
Numbers booklet included with the computer. You can also find contact information from the HP
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website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.
IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you want to retain.
Using HP Recovery media, you can choose from one of the following recovery options:
NOTE:

Only the options available for your computer display when you start the recovery process.

●

System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

●

Factory Reset—Restores the computer to its original factory state by deleting all information from the
storage device and re-creating the partitions. Then it reinstalls the operating system and the software
that was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)
The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a
recovery USB flash drive. This type of recovery can be used only if the storage device is still working.
To start HP Recovery Manager from the HP Recovery partition:
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps (select products only).
1.

Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery
Environment.
- orFor computers or tablets with keyboards attached, press f11 while the computer boots, or press and
hold f11 as you press the power button.
For tablets without keyboards:
Turn on or restart the tablet, and then quickly hold down the volume down button; then select f11.
- or Turn on or restart the tablet, and then quickly hold down the Windows button; then select f11.

2.

Select Troubleshoot from the boot options menu.

3.

Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover
You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the storage device is not working properly.
1.

If possible, back up all personal files.

2.

Insert the HP Recovery media, and then restart the computer.
NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 159.

3.

Follow the on-screen instructions.
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Changing the computer boot order
If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is
the order of devices listed in BIOS where the computer looks for startup information. You can change the
selection to an optical drive or a USB flash drive.
To change the boot order:
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps.
1.

Insert the HP Recovery media.

2.

Access BIOS:
For computers or tablets with keyboards attached:
▲

Turn on or restart the computer or tablet, quickly press esc, and then press f9 for boot options.

For tablets without keyboards:
▲

Turn on or restart the tablet, and then quickly hold down the volume down button; then select f9.
- or Turn on or restart the tablet, and then quickly hold down the Windows button; then select f9.

3.

Select the optical drive or USB flash drive from which you want to boot.

4.

Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)
HP Recovery Manager software allows you to remove the HP Recovery partition to free up storage device
space.
IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition,
create HP Recovery media; see Creating HP Recovery media (select products only) on page 155.
NOTE:

The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

Select Remove Recovery Partition, and then follow the on-screen instructions.
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13 Specifications
Computer specifications
Metric

U.S.

Width

375 mm

14.76 in

Depth

255 mm

10.04 in

Height (front to rear, LED display assembly)

18 mm

0.71 in

Weight (computer equipped with Intel Dual Core processor,
500-GB hard drive, optical drive, one memory module,
WLAN module, fingerprint reader, modem module, and 8cell battery)

2.93 kg

6.45 lb

Weight (computer equipped with Intel Dual Core processor
one memory module, 128-GB solid-state drive, WLAN
module, fingerprint reader, and 8-cell battery)

2.16 kg

4.76 lb

Dimensions

Input power
Operating voltage and current

19.5 V dc @ 6.15 A - 120 W, Slim Smart AC Adapter (select models only)
19.5 V dc @ 7.69 A - 150 W, Slim Smart AC Adapter (select models only)
19.5 V dc @ 10.3A - 200 W, Slim Smart AC Adapter (select models only)

Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

‑20°C to 60°C

‑4°F to 140°F

Relative humidity (non-condensing)
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating

‑15 m to 3,048 m

‑50 ft to 10,000 ft

Nonoperating

‑15 m to 12,192 m

‑50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this range of
temperatures.
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14 Statement of memory volatility
The purpose of this chapter is to provide general information regarding nonvolatile memory in HP Business
PCs. This chapter also provides general instructions for restoring nonvolatile memory that can contain
personal data after the system has been powered off and the storage device has been removed.
HP Business PC products that use Intel®-based or AMD®-based system boards contain volatile DDR memory.
The amount of nonvolatile memory present in the system depends upon the system configuration. Intelbased and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped from
HP, assuming that no subsequent modifications have been made to the system and assuming that no
applications, features, or functionality have been added to or installed on the system.
Following system shutdown and removal of all power sources from an HP Business PC system, personal data
can remain on volatile system memory (DIMMs) for a finite period of time and will also remain in nonvolatile
memory. Use the steps below to remove personal data from the PC, including the nonvolatile memory found
in Intel-based and AMD-based system boards.
NOTE: If your tablet has a keyboard base, connect to the keyboard base before beginning steps in this
chapter.
Current BIOS steps
1.

Follow steps (a) through (l) below to restore the nonvolatile memory that can contain personal data.
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary
nor recommended.
a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.
IMPORTANT: If the Main menu displays Restore Defaults instead of Apply Factory Defaults and
Exit, go to Legacy BIOS Steps on page 162.
NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

b.

Select Main, select Apply Factory Defaults and Exit, and then select Yes to load defaults.
The computer will reboot.

c.

During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.
NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

d.

Select the Security menu, select Restore Security Settings to Factory Defaults, and then select
Yes to restore security level defaults.
The computer will reboot.

e.

During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.
NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

f.

If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select Asset Tracking Number. Clear the tag, and then make the
selection to return to the prior menu.
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g.

If a DriveLock password is set, select the Security menu, and scroll down to Hard Drive Utilities
under the Utilities menu. Select Hard Drive Utilities, select DriveLock, then uncheck the checkbox
for DriveLock password on restart. Select OK to proceed.

h.

Select the Main menu, and then select Reset BIOS Security to factory default. Click Yes at the
warning message.
The computer will reboot.

i.

During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.
NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

2.

j.

Select the Main menu, select Apply Factory Defaults and Exit, select Yes to save changes and exit,
and then select Shutdown.

k.

Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint reader,
one or two prompts will appear—one to clear the TPM and the other to Reset Fingerprint Sensor;
press or tap F1 to accept or F2 to reject.

l.

Remove all power and system batteries for at least 24 hours.

Complete one of the following:
●

Remove and retain the storage drive.

– or –
●

Clear the drive contents by using a third party utility designed to erase data from an SSD.

– or –
●

Clear the contents of the drive by using the following BIOS Setup Secure Erase command option
steps:

IMPORTANT:

If you clear data using Secure Erase, it cannot be recovered.

a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.

b.

Select the Security menu and scroll down to the Utilities menu.

c.

Select Hard Drive Tools.

d.

Under Utilities, select Secure Erase, select the storage device storing the data you want to clear,
and then follow the on-screen instructions to continue.

Legacy BIOS Steps
Use the steps for older versions of BIOS.
NOTE:
1.

If you already completed the steps in Current BIOS steps on page 161, skip this section.

Follow steps (a) through (i) below to restore the nonvolatile memory that can contain personal data.
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary
nor recommended.
NOTE: If you have not already done so, access the BIOS menu.
●

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.
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NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

2.

a.

Select Main, select Restore Defaults, and then select Yes to load defaults.

b.

Select the Security menu, select Restore Security Level Defaults, and then select Yes to restore
security level defaults.

c.

If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select Asset Tracking Number. Clear the tag, and then make the
selection to return to the prior menu.

d.

If a DriveLock password is set, select the Security menu, and scroll down to Hard Drive Tools
under the Utilities menu. Select Hard Drive Tools, select DriveLock, then uncheck the checkbox
for DriveLock password on restart. Select OK to proceed.

e.

If an Automatic DriveLock password is set, select the Security menu, scroll down to Hard Drive
Tools under the Utilities menu. Select Hard Drive Tools, scroll down to Automatic DriveLock, then
select the desired storage device and disable protection. At the automatic drive lock warning
screen, select Yes to continue. Repeat this procedure if more than one storage device has an
Automatic DriveLock password.

f.

Select the Main menu, and then select Reset BIOS Security to factory default. Click Yes at the
warning message.

g.

Select the Main menu, select Save Changes and Exit, select Yes to save changes and exit, and then
select Shutdown.

h.

Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint reader,
one or two prompts will appear—one to clear the TPM and the other to Reset Fingerprint Sensor;
press or tap F1 to accept or F2 to reject.

i.

Remove all power and system batteries for at least 24 hours.

Complete one of the following:
●

Remove and retain the storage drive.

– or –
●

Clear the drive contents by using a third party utility designed to erase data from an SSD.

– or –
●

Clear the contents of the drive by using the following BIOS Setup Secure Erase command option
steps:

IMPORTANT:

If you clear data using Secure Erase, it cannot be recovered.

a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.

b.

Select the Security menu and scroll down to the Utilities menu.

c.

Select Hard Drive Tools.

d.

Under Utilities, select Secure Erase, select the storage device storing the data you want to clear,
and then follow the on-screen instructions to continue.

– or –
●

Clear the contents of the drive by using the following Disk Sanitizer command steps:

IMPORTANT:

If you clear data using Disk Sanitizer, it cannot be recovered.
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NOTE: The amount of time it takes for Disk Sanitizer to run can take several hours. Plug the computer
into an AC outlet before starting.
a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.

b.

Select the Security menu and scroll down to the Utilities menu.

c.

Select Hard Drive Tools.

d.

Under Utilities, select Disk Sanitizer, select the storage device storing the data you want to clear,
and then follow the on-screen instructions to continue.
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Nonvolatile memory usage

Nonvolatile
Memory Type
HP Sure Start flash
(select models
only)

Amount (Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

2 MBytes

No

Yes

What is the
purpose of this
memory?
Provides
protected
backup of
critical System
BIOS code, EC
firmware, and
critical PC
configuration
data for select
platforms that
support HP
Sure Start.

How is data input into this
memory?

How is this memory
write-protected?

Data cannot be written to this
device via the host processor.
The content is managed
solely by the HP Sure Start
Embedded Controller.

This memory is protected
by the HP Sure Start
Embedded Controller.

For more
information,
see Using HP
Sure Start
(select models
only)
on page 168.
Real Time Clock
(RTC) battery
backed-up CMOS
configuration
memory

256 Bytes

No

Yes

Stores system
date and time
and noncritical
data.

RTC battery backed-up CMOS
is programmed using the
Computer Setup (BIOS), or
changing the Windows date &
time.

This memory is not writeprotected.

Controller (NIC)
EEPROM

64 KBytes (not
customer
accessible)

No

Yes

Stores NIC
configuration
and NIC
firmware.

NIC EEPROM is programmed
using a utility from the NIC
vendor that can be run from
DOS.

A utility is required to
write data to this memory
and is available from the
NIC vendor. Writing data
to this ROM in an
inappropriate manner will
render the NIC nonfunctional.

DIMM Serial
Presence Detect
(SPD)
configuration data

256 Bytes per
memory
module, 128
Bytes
programmable
(not customer
accessible)

No

Yes

Stores memory
module
information.

DIMM SPD is programmed by
the memory vendor.

Data cannot be written to
this memory when the
module is installed in a
PC. The specific writeprotection method varies
by memory vendor.

System BIOS

4 MBytes to 5
MBytes

Yes

Yes

Stores system
BIOS code and
PC
configuration
data.

System BIOS code is
programmed at the factory.
Code is updated when the
system BIOS is updated.
Configuration data and
settings are input using the
Computer Setup (BIOS) or a
custom utility.

NOTE: Writing data to
this ROM in an
inappropriate manner can
render the PC nonfunctional.
A utility is required for
writing data to this
memory and is available
on the HP website; go to
http://www.hp.com/
support, and select your
country. Select Drivers &

Nonvolatile memory usage 165

Nonvolatile
Memory Type

Amount (Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of this
memory?

How is data input into this
memory?

How is this memory
write-protected?
Downloads, and then
follow the on-screen
instructions.

Intel Management 1.5 MBytes or 5
Engine Firmware
MBytes
(present in only
specific ZBook and
EliteBook models.
For more
information, go to
http://www.hp.com/
support, and
select your
country. Select
Drivers &
Downloads, and
then follow the
on-screen
instructions.)

Yes

Yes

Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third-party data
store.

Management Engine Code is
programmed at the factory.
Code is updated via Intel
secure firmware update
utility. Unique Provisioning
Data can be entered at the
factory or by an
administrator using the
Management Engine (MEBx)
setup utility. The third party
data store contents can be
populated by a remote
management console or local
applications that have been
registered by an
administrator to have access
to the space.

The Intel chipset is
configured to enforce
hardware protection to
block all direct read/write
access to this area. An
Intel utility is required for
updating the firmware.
Only firmware updates
digitally signed by Intel
can be applied using this
utility.

Bluetooth flash

2 Mbit

No

Yes

Stores
Bluetooth
configuration
and firmware.

Bluetooth flash is
programmed at the factory.
Tools for writing data to this
memory are not publicly
available but can be obtained
from the silicon vendor.

A utility is required for
writing data to this
memory and is made
available through newer
versions of the driver
whenever the flash
requires an upgrade.

802.11 WLAN
EEPROM

4 Kbit to 8 Kbit

No

Yes

Stores
configuration
and calibration
data.

802.11 WLAN EEPROM is
programmed at the factory.
Tools for writing data to this
memory are not made public.

A utility is required for
writing data to this
memory and is typically
not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.

Web camera

64 Kbit

No

Yes

Stores webcam
configuration
and firmware.

Webcam memory is
programmed using a utility
from the device
manufacturer that can be run
from Windows.

A utility is required for
writing data to this
memory and is typically
not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.

Fingerprint reader

512 KByte flash

Yes

Yes

Stores
fingerprint
templates.

Fingerprint reader memory is
programmed by user
enrollment in HP
ProtectTools Security
Manager.

Only a digitally signed
application can make the
call to write to the flash.

166 Chapter 14 Statement of memory volatility

Questions and answers
1.

How can the BIOS settings be restored (returned to factory settings)?
IMPORTANT: Restore defaults does not securely erase any data on your storage device. See question
and answer 6 for steps to securely erase data.
Restore defaults does not reset the Custom Secure Boot keys. See question and answer 7 for
information about resetting the keys.

2.

a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.

b.

Select Main, and then select Restore defaults.

c.

Follow the on-screen instructions.

d.

Select Main, select Save Changes and Exit, and then follow the on-screen instructions.

What is a UEFI BIOS, and how is it different from a legacy BIOS?
The Unified Extensible Firmware Interface (UEFI) BIOS is an industry-standard software interface
between the platform firmware and an operating system (OS). It is a replacement for the older BIOS
architecture, but supports much of the legacy BIOS functionality.
Like the legacy BIOS, the UEFI BIOS provides an interface to display the system information and
configuration settings and to change the configuration of your computer before an OS is loaded. BIOS
provides a secure run-time environment that supports a Graphic User Interface (GUI). In this
environment, you can use either a pointing device (touch screen, TouchPad, pointing stick, or USB
mouse) or the keyboard to navigate and make menu and configuration selections. The UEFI BIOS also
contains basic system diagnostics.
The UEFI BIOS provides functionality beyond that of the legacy BIOS. In addition, the UEFI BIOS works to
initialize the computer’s hardware before loading and executing the OS; the run-time environment
allows the loading and execution of software programs from storage devices to provide more
functionality, such as advanced hardware diagnostics (with the ability to display more detailed system
information) and advanced firmware management and recovery software.
HP has provided options in Computer Setup (BIOS) to allow you to run in legacy BIOS, if required by the
operating system. Examples of this requirement would be if you upgrade or downgrade the OS.

3.

Where does the UEFI BIOS reside?
The UEFI BIOS resides on a flash memory chip. A utility is required to write to the chip.

4.

What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory
module? How would this data be written?
The DIMM SPD memory contains information about the memory module, such as size, serial number,
data width, speed/timing, voltage, and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a PC. Third-party tools do exist that can write to the EEPROM when the memory module is
not installed in a PC. Various third-party tools are available to read SPD memory.

5.

What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?
This message relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration
data.

6.

How can the BIOS security be reset to factory defaults and data erased?
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IMPORTANT:

Resetting will result in the loss of information.

These steps will not reset Custom Secure Boot Keys. See question and answer 7 for information about
resetting the keys.

7.

a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.

b.

Select Main, and then select Reset BIOS Security to Factory Default.

c.

Follow the on-screen instructions.

d.

Select Main, select Save Changes and Exit, and then follow the on-screen instructions.

How can the Custom Secure Boot Keys be reset?
Secure Boot is a feature to ensure that only authenticated code can start on a platform. If you enabled
Secure Boot and created Custom Secure Boot Keys, simply disabling Secure Boot will not clear the keys.
You must also select to clear the Custom Secure Boot Keys. Use the same Secure Boot access procedure
you used to create the Custom Secure Boot Keys, but make the selection to clear or delete all Secure
Boot Keys.
a.

Turn on or restart the computer, and then press esc while the "Press the ESC key for Startup Menu"
message is displayed at the bottom of the screen.

b.

Select the Security menu, select Secure Boot Configuration, and then follow the on-screen
instructions.

c.

At the Secure Boot Configuration window, select Secure Boot, select Clear Secure Boot Keys, and
then follow the on-screen instructions to continue.

Using HP Sure Start (select models only)
Select computer models are configured with HP Sure Start, a technology that continuously monitors your
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start
restores the BIOS to its previously safe state, without user intervention. HP Sure Start is configured and
already enabled so that most users can use the HP Sure Start default configuration. The default configuration
can be customized by advanced users.
To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your
country. Select Drivers & Downloads, and then follow the on-screen instructions.
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15 Recycling
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/recycle.
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Index
Symbols/Numerics
2nd SSD bracket
illustrated 20
A
AC adapter and/battery 11
AC adapter, spare part numbers 22
antennas
removal 59, 60
spare part number 60
audio, product description 3
audio-out (headphone)/audio-in
(microphone) combo jack,
identifying 11
B
Backup and Restore 152
backup tools 150
backups 155
creating 151
recovering 152
battery
removal 32
spare part numbers 18, 32
battery light 12
BIOS
determining version 140, 145
downloading an update 140,
145
updating 140, 145
Blu-ray R/RE DVD±RW SuperMulti
Double-Layer Drive
precautions 25
Blu-ray ROM DVD±RW SuperMulti
Double-Layer Drive
precautions 25
Bluetooth label 14
boot order
changing 159
bottom 14
bottom cover
removal 31
spare part number 31
bottom cover, spare part number
18
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Bracket Kit
spare part number
buttons
power 9

20

C
cables, service considerations 25
caps lock light, identifying 8
card reader insert
illustrated 21
chipset, product description 1
components
bottom 13
display 6
front 12
left side 10
right side 11
top 7
computer
major components 15
specifications 160
Computer Setup
navigating and selecting 138,
143
restoring factory settings 139,
144
connector, power 11
connectors, service considerations
25
D
display assembly
removal 54
spare part numbers 16, 54
display bezel
removal 55
spare part numbers 19, 56
display brackets
removal 59
display cable
removal 46
spare part number 46, 60
display cable bracket
spare part number 17

display enclosure
spare part numbers 19
display panel
product description 1
removal 56
spare part numbers 19
display panel bracket
illustrated 20
docking
product description 3
drive light 12
Driver Recovery DVD,
creating 150
using for restore 153
drives, preventing damage 25
DVD-ROM Drive
precautions 25
DVD±RW SuperMulti Double-Layer
Drive
precautions 25
E
EDP bracket
illustrated 20
eDP bracket
spare part number 17
electrostatic discharge 25
equipment guidelines 28
Ethernet, product description

3

F
f11 recovery 153
fan/heat sink assembly
spare part numbers 17
fingerprint reader board
removal 43
spare part number 16, 43
fingerprint reader board bracket
removal 43
fingerprint reader insert
illustrated 21
fingerprint reader, identifying 10
G
graphics, product description 1

grounding guidelines
guidelines
equipment 28
grounding 25
packaging 27
transporting 27
workstation 27

25

H
HDMI port, identifying 11
hinge
removal 58
spare part number 19, 59
HP PC Hardware Diagnostics (UEFI)
using 148
HP Recovery Disc Creator, using 150
HP Recovery Manager
correcting boot problems 159
starting 158
HP Recovery media
creating 155
recovery 158
HP Recovery partition
checking for presence 153
recovery 158
removing 159
using for recovery 153
HP Sure Start 168
I
I/O support bracket
illustrated 20
removal 50
spare part number 17, 50
integrated webcam light,
identifying 6
internal microphones, identifying 6
J
jacks
audio-out (headphone)/audio-in
(microphone) combo 11
network 10
RJ-45 (network) 10
K
keyboard
product description 3
removal 52
spare part numbers 16, 52

L
labels
Bluetooth 14
regulatory 14
serial number 14
service 14
wireless certification 14
WLAN 14
LED board
removal 44
spare part number 17, 44
legacy support, USB 138, 143
lights
AC adapter and battery 11
battery 12
caps lock 8
drive 12
microphone mute 8
num lock 8
power 8, 12
RJ-45 (network) 10
TouchPad 8
webcam 6
wireless 8, 12
M
mass storage device
precautions 25
memory
nonvolatile 161
volatile 161
memory card reader, identifying 10
memory module
product description 2
removal 37
spare part numbers 18, 37
microphone
product description 3
microphone module
removal 57
spare part number 58
microphone mute light, identifying
8
minimized image recovery 158
minimized image, creating 157
model name 1
N
network jack, identifying 10
nonvolatile memory 161

num lock light 8
O
operating system, product
description 4
optical drive
precautions 25
original system recovery 157
P
packaging guidelines 27
plastic parts, service
considerations 24
Plastics Kit
spare part number 21
pointing device, product
description 3
ports
HDMI 11
product description 3
USB 3.0 charging (powered) 10
USB Type-C (charging) 11
power button, identifying 9
power connector, identifying 11
power lights 8, 12
power requirements, product
description 4
processor
product description 1
product description
audio 3
chipset 1
display panel 1
docking 3
Ethernet 3
external media cards 3
graphics 1
keyboard 3
memory module 2
microphone 3
operating system 4
pointing device 3
ports 3
power requirements 4
processor 1
product name 1
security 4
serviceability 5
solid-state drive 2
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video 3
wireless 3
product name 1
product name and number,
computer 14
R
recover
options 157
recovery
discs 156, 158
HP Recovery Manager 157
media 158
starting 158
supported discs 156
system 157
USB flash drive 158
using HP Recovery media 156
recovery media
creating 155
creating using HP Recovery
Manager 156
recovery media, creating 150
recovery media, using for restore
153
recovery partition 153
removing 159
recovery tools 150
recovery tools, Windows 152
recovery, system 152
regulatory information
regulatory label 14
wireless certification labels 14
removal/replacement
procedures 29, 40
removing personal data from volatile
system memory 161
restoring the storage device 153
RJ-45 (network) jack, identifying 10
RJ-45 (network) lights, identifying
10
RTC battery
removal 39
spare part number 16, 39
S
Screw Kit, spare part number 23
security cable slot, identifying 10
security, product description 4
serial number 14
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serial number, computer 14
service considerations
cables 25
connectors 25
plastic parts 24
service door
removal 30
spare part number 18, 30
service labels, locating 14
serviceability, product description 5
setup utility
navigating and selecting 138,
143
restoring factory settings 139,
144
slots
security cable 10
solid-state drive
precautions 25
product description 2
removal 33
spare part numbers 17, 33
Speaker Kit, spare part number 17
speakers
removal 51
spare part number 17, 51
speakers, identifying 10
specifications
computer 160
Startup Repair, using 152
storage device
precautions 25
storage device recovery 153
supported discs, recovery 156
Sure Start
using 142, 147
system board
removal 47
spare part numbers 17, 47
system memory, removing personal
data from volatile 161
system recovery 157
system restore point
creating 156
system restore point, creating 155
T
thermal board
removal 58
spare part number

19, 58

thermal module
removal 40
spare part numbers 40
tools required 24
top cover
spare part number 16, 61
TouchPad
removal 45
spare part number 16, 45
TouchPad light, identifying 8
TouchPad zone
identifying 7
TPM settings 141, 146
transporting guidelines 27
traveling with the computer 14
U
USB 3.0 charging (powered),
identifying 10
USB 3.0 port 10, 11
USB legacy support 138, 143
USB ports, identifying 10, 11
USB Type-C (charging) port,
identifying 11
V
vent, identifying 13
video, product description 3
W
webcam 6
webcam light, identifying 6
webcam module
removal 57
spare part number 19, 58
webcam, identifying 6
Windows
system restore point 155, 156
Windows 7 operating system DVD
creating 150
using for restore 153
Windows 7 operating system media
creating 150
using for restore 153
Windows Startup Repair, using 152
Windows tools
using 156
wireless certification label 14
wireless light 8, 12
wireless, product description 3
WLAN antennas, identifying 6

WLAN device 14
WLAN label 14
WLAN module
removal 35
spare part numbers 18, 35
workstation guidelines 27
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